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Preface

Preface

Welcome to the Trend Micro™ InterScan™ Web Security Virtual Appliance 6.5 SP2 
Installation Guide. This guide helps you to get “up and running” by introducing InterScan 
Web Security Virtual Appliance (IWSVA), assisting with deployment, installation, 
migration (if necessary), initial configuration, troubleshooting, performance tuning, and 
main post-installation configuration tasks. It also includes instructions on testing your 
installation using a harmless test virus, troubleshooting, and accessing support.

This preface describes the following topics: 

• Audience on page x

• IWSVA Documentation on page xii

• Document Conventions on page xiii

• About Trend Micro on page xiii
1-ix
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Audience
The IWSVA documentation is written for IT managers and system administrators 
working in enterprise environments. The documentation assumes that the reader has 
in-depth knowledge of networks schemas, including details related to the following:

• HTTP, HTTPS, FTP and other Internet protocols used by an enterprise

• VMware ESX administration experience when installing on VMware ESX and 
Microsoft Hyper-V experience when installing on Hyper-V virtual platforms.

The documentation does not assume the reader has any knowledge of antivirus or Web 
security technology.

How to Use this Guide
This guide contains the information you need to understand and use IWSVA.

If you are an advanced user, you might want to go directly to Chapter 3, Installing 
InterScan Web Security Virtual Appliance. If you are installing IWSVA on VMware ESX, see 
Appendix E, Creating a New Virtual Machine Under VMware ESX for IWSVA. If you are 
installing IWSVA on Microsoft Hyper-V, see Appendix F, Creating a New Virtual Machine 
Under Microsoft Hyper-V for IWSVA. 

Chapter 1, Preinstallation Plan-
ning

This chapter describes the tasks you need to do 
before installing IWSVA. This includes planning 
for network traffic and HTTP and FTP service 
flows and ensuring that your server meets specific 
requirements.

Chapter 2, Deployment Primer This chapter provides an overview of the different 
topologies in which IWSVA can be installed and 
helps you plan your server placement and net-
work protection with HTTP and FTP service 
flows.

Chapter 3, Installing InterScan 
Web Security Virtual Appliance

This chapter describes how to obtain either a 
evaluation or production version of IWSVA and 
how to install the application.
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Chapter 4, Migrating to Inter-
Scan Web Security Virtual Appli-
ance

This chapter describes the different migration sce-
narios and how to complete a migration to 
IWSVA.

Appendix A, Deployment Inte-
gration

This appendix describes deployment scenarios for 
IWSVA, involving several technologies such as 
LDAP, Cisco routers using WCCP, ICAP, and 
Transparent Bridge.

Appendix B, Tuning and Trou-
bleshooting

This appendix describes performance tuning 
involving URL filtering and LDAP performance. 
Also, this appendix provides general trouble-
shooting tips and possible installation and feature 
issues.

Appendix C, Best Practices for 
IWSVA Installation and Deploy-
ment

This appendix describes the installation and 
deployment best practices that Trend Micro rec-
ommends for IWSVA

Appendix D, Maintenance and 
Technical Support

This appendix describes the maintenance agree-
ment and the aspects of the Trend Micro Techni-
cal Support Center.

Appendix E, Creating a New 
Virtual Machine Under VMware 
ESX for IWSVA

This appendix describes how to create a new vir-
tual machine for IWSVA under VMware ESX.

Appendix F, Creating a New 
Virtual Machine Under Micro-
soft Hyper-V for IWSVA

This appendix describes how to create a new vir-
tual machine for IWSVA under Microsoft 
Hyper-V.
1-xi
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IWSVA Documentation
In addition to the Trend Micro™ InterScan Web Security Virtual Appliance 6.5 SP2 Installation 
Guide, the documentation set includes the following:

• Administrator’s Guide—this guide provides detailed information about all 
IWSVA configuration options. Topics include how to update your software to keep 
protection current against the latest risks, how to configure and use policies to 
support your security objectives, and using logs and reports.

• Readme file—the Readme file contains late-breaking product information that is 
not found in the online or printed documentation. Topics include a description of 
new features, installation tips, known issues, and release history.

The latest versions of the Installation Guide, Administrator’s Guide, and readme file 
are available in electronic form at:

http://downloadcenter.trendmicro.com/index.php?clk=tbl&clkv
al=1747&regs=NABU&lang_loc=1#undefined

DVD ISO creation document—Entitled, How to Use the Trend Micro IWSVA ISO 
File, this document describes how to create a bootable installation DVD from an 
ISO file.

Online Help—Helps you configure all features through the user interface. You can 
access the online help by opening the Web console and then clicking the help icon. 
The purpose of Online Help is to provide “how to’s” for the main product tasks, 
usage advice, and field-specific information such as valid parameter ranges and 
optimal values. Online Help is accessible from the IWSVA management console.

• Knowledge Base—The Knowledge Base is an online database of problem-solving 
and troubleshooting information. It provides the latest information about known 
product issues. To access the Knowledge Base, open:

http://esupport.trendmicro.com/support
1-xii
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Document Conventions
To help you locate and interpret information easily, the InterScan Web Security Virtual 
Appliance documentation uses the following conventions.

About Trend Micro
Trend Micro, Inc. is a global leader in network antivirus and Internet content security 
software and services. Founded in 1988, Trend Micro led the migration of virus 
protection from the desktop to the network server and the Internet gateway-gaining a 
reputation for vision and technological innovation along the way.

Today, Trend Micro focuses on providing customers with comprehensive security 
strategies to manage the impacts of risks to information, by offering centrally controlled 
server-based virus protection and content-filtering products and services. By protecting 

TABLE 1-1.   Document Conventions

CONVENTION DESCRIPTION

ALL CAPITALS Acronyms, abbreviations, and names of certain commands 
and keys on the keyboard

Bold Menus and menu commands, command buttons, tabs, 
options, and ScanMail tasks

Italics References to other documentation

Monospace Examples, sample command lines, program code, Web URL, 
file name, and program output

Note:
Configuration notes

Tip:  
Recommendations

WARNING!
Reminders on actions or configurations that should be 
avoided
1-xiii
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information that flows through Internet gateways, email servers, and file servers, Trend 
Micro allows companies and service providers worldwide to stop viruses and other 
malicious code from a central point, before they ever reach the desktop.

For more information, or to download evaluation copies of Trend Micro products, visit 
our award-winning Web site:

http://www.trendmicro.com
1-xiv
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Preinstallation Planning

This chapter describes the following:

• Server Requirements on page 1-2

• Information Needed to Install IWSVA on page 1-6

• Planning Network Traffic Protection on page 1-8
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Server Requirements

Operating System
A purpose-built, hardened, and performance-tuned 64-bit operating system is included 
with InterScan Web Security Virtual Appliance (IWSVA).

Hardware Requirements
The minimum requirements specified provide enough resources to properly evaluate the 
product under light traffic loads. The recommended requirements specified provide 
general production sizing guidance. 

For more detailed sizing information, refer to the IWSVA Sizing Guide at: 

http://trendedge.trendmicro.com/pr/tm/te/web-security.aspx

Search for “sizing guide”.

Minimum Requirements:

• Single 2.0 GHz Intel ™ Core2Duo™ 64-bit processor supporting Intel™ VT™ or 
equivalent

• 4GB RAM

• 50GB of disk space. (IWSVA automatically partitions the detected disk space as 
required)

Note: 50GB of disk space is only appropriate for the testing environment. See 
Recommended Requirements: on page 1-2 for the disk space in the production 
environment.

Recommended Requirements:

• Dual 2.8 GHz Intel Core2Duo 64-bit processor or equivalent for up to 4000 users

• Dual 3.16 GHz Intel QuadCore 64-bit processor or equivalent for up to 9500 users

• 300GB of disk space or more for log intensive environments. IWSVA automatically 
partitions the detected disk space as per recommended Linux practices
1-2
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Server Platform Compatibility

IWSVA should install and operate without issues on many brands of “off-the-shelf ” 
server platforms. However, Trend Micro cannot guarantee 100% compatibility with all 
brands and models of server platforms.

To obtain a list of Trend Micro certified servers that are compatible with IWSVA, access 
the following URL:

http://www.trendmicro.com/go/certified 

To obtain a general list of available platforms that should operate with IWSVA, access 
the following URL:

http://wiki.centos.org/HardwareList 

Trend Micro cannot guarantee full compatibility with the hardware components from 
this general list.

Component Installation
During installation, the following Trend Micro components are automatically installed:

• Main Program—Management console and the basic library files necessary for 
IWSVA.

• Application Control—Service to control application usage by protocol.

• Bandwidth Control—Service to control bandwidth usage by application.

• HTTP Malware Scan—Service necessary for HTTP scanning (either ICAP or 
HTTP proxy) and URL blocking.

• FTP Scanning—Service necessary for FTP scanning.

• URL Filtering—Service necessary for URL filtering.

• Applets and ActiveX Scanning—Service necessary for scanning Java applets and 
ActiveX controls.

• SNMP Notifications—Service to send SNMP traps to SNMP-compliant network 
management software.

• Control Manager Agent for IWSVA—Files necessary for the Control Manager 
agent. You need to install the agent if you are using Control Manager (Trend Micro’s 
central management console).
1-3
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• Command Line Interface—A custom CLI shell to manage IWSVA from the 
command line, either by TTY or SSH.

During installation, Apache Traffic Server (ATS) application is installed for convenience, 
but is not enabled by default:

• Apache Traffic Server (ATS)

Web Browser
To access the HTTP-based Web console, use any of the browsers in Table 1-1.

To access the Internet through IWSVA, use any of the browsers in Table 1-2.

TABLE 1-1.   Supported Web Browsers for Web Console Access 

BROWSER WINDOWS LINUX

XP Windows 7 SP1 CentOS 6

IE 9.0, 10 ✔

Firefox 39+ ✔ ✔

Google Chrome 44+ ✔

TABLE 1-2.   Supported Web Browsers for Internet Access 

BROWSER
WINDOWS

LINUX MAC

WINDOWS 7 SP1 CENTOS 6 OS X

IE 8.0

IE 9.0, 10, 11 ✔

Firefox 39+ ✔

Safari 7, 8+ ✔

Google Chrome 44+ ✔
1-4



Preinstallation Planning
Other Requirements
• Internet Content Adaptation Protocol (ICAP):

• NetApp™ NetCache™ release 6.0.1

• Blue Coat Systems™ SGOS v5 

• Cisco ICAP servers: CE version 5.3

• Any cache server that is ICAP 1.0 compliant 

• Directory Servers:

To configure policies based on Lightweight Directory Access Protocol (LDAP) 
users and groups, IWSVA can integrate with the following LDAP directories:

• Microsoft Active Directory 2003, 2008, and 2012.

• Linux OpenLDAP Directory 2.2.16 or 2.3.39

• Sun™ Java System Directory Server 5.2 (formerly Sun™ ONE Directory 
Server)

• Novell eDirectory 8.8

• Transparent Bridge: 

• Each transparent bridge segment supported by IWSVA requires two network 
interface cards.

• Web Cache Content Protocol (WCCP):

Trend Micro recommends using the following Cisco IOS versions when configuring 
WCCP with IWSVA:

• 12.2(0) to 12.2(22). Avoid using releases 23 and above within the 12.2 family

• 12.3(10) and above. Avoid using releases 0-9 in the 12.3 family

• IOS 15.1(1)T3 or above should be used

• Other Requirements:

• For proxy deployment modes, network clients must be able to access the HTTP 
port of the IWSVA server that is selected during the install.

• IWSVA server and clients must be able to communicate with each other over the 
corporate network.
1-5
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Information Needed to Install IWSVA
You can either purchase or download a 30-day trial version of IWSVA. The 30-day trial 
version provides all the functionality of IWSVA.

The IWSVA setup program prompts you for required information, depending on the 
options chosen during installation.

Before beginning, determine the type of installation you should do:

• For new customers doing fresh installations, see Chapter 2, Deployment Primer on 
page 2-1 for product placement advice and Chapter 3, Installing InterScan Web 
Security Virtual Appliance on page 3-1.

• For returning customer migrating from older versions of IWSVA, see Chapter 4, 
Chapter 4, Migrating to InterScan Web Security Virtual Appliance to migrate data 
and Chapter 3, Installing InterScan Web Security Virtual Appliance on page 3-1 for 
fresh installation instructions.

Fresh Installation
IWSVA 6.5 SP2 supports fresh installations and upgrades from IWSVA 6.5 SP1. 
Upgrading an existing IWSS or IWSA installation is not supported. The fresh 
installation process formats your existing system to install IWSVA. (see Installing 
IWSVA on page 3-4).

Migration
IWSVA 6.5 SP2 supports existing configuration and policy data migration from the 
following Trend Micro Products:

• InterScan Web Security Virtual Appliance 6.5 (same language version)

• InterScan Web Security Virtual Appliance 6.5 SP1 (same language version) 

For more information about migration, see Chapter 4, Migrating to InterScan Web 
Security Virtual Appliance.

Type of Proxy Configuration
IWSVA supports multiple deployment modes.
1-6
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• Forward proxy where clients directly connect to IWSVA.

• Upstream proxy to another existing internal proxy server

• ICAP Server to an existing ICAP 1.0 compliant cache controller

• WCCP client to a configured WCCP-enabled router of firewall

• Transparent Bridge Mode

• Reverse proxy to protect Web servers

The deployment is configured after the IWSVA installation and it can be changed using 
the Deployment Wizard in the Web console. Each transparent bridge segment 
supported by IWSVA requires two network interface cards. See Planning the HTTP 
Flow on page 2-5 and Planning FTP Flows on page 2-7.

Control Manager Server Information
Control Manager registration is performed through the IWSVA Web console after the 
IWSVA installation is complete.

Database Type and Location
IWSVA uses the PostgreSQL database for policies, rules, and configuration settings. A 
local PostgreSQL installation is performed during IWSVA installation.

SNMP Notifications
If you plan to use SNMP notifications, the IWSVA setup program installs the 
appropriate SNMP libraries.

Web Console Password
Access to the IWSVA Web console is controlled initially through a default username 
“admin.” The password is set during installation from the ISO file.

Tip:  For security reasons, Trend Micro recommends that you change the admin password 
after you log in to the Web console the first time.
1-7
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Tip:  The password for OS account "root" and CLI account "enable" and IWSVA account 
"admin" are the same after installing from ISO file. The IWSVA administrator can make 
them different. For details, refer to the Administrator’s Guide.

Command Line Access
IWSVA provides a Command Line Interface (CLI) to allow configuration of the 
appliance using an industry standard CLI syntax. The CLI offers additional commands 
and functionality to manage, troubleshoot, and maintain within IWSVA. The CLI can be 
accessed using a local console keyboard and monitor or remotely through SSHv2. 

Proxy for Internet Updates
If you have a proxy host between IWSVA and the Internet, you must configure the 
IWSVA's proxy settings in order to receive updates from Trend Micro. From the menu, 
choose Updates > Connection Settings to configure the upstream proxy settings. See 
the Administrator’s Guide for more details.

Activation Codes
Activating the three IWSVA modules (core program, URL Filtering, and Applet and 
ActiveX Scanning) requires a single activation code. IWSVA includes one registration 
key for all the modules. During product registration, the Registration Key is exchanged 
for an Activation Code that “unlocks” the program. You can register the installation and 
exchange the registration key for an activation code from a link in the setup program. 
Alternatively, you can register and obtain an activation code before installing by visiting 
Trend Micro’s online registration Web site at:

https://olr.trendmicro.com

Planning Network Traffic Protection
IWSVA can be deployed in different modes to help secure your network. (See Chapter 2, 
Deployment Primer). IWSVA supports the following deployment topologies:

• Transparent Bridge Mode on page 1-9
1-8
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• Forward Proxy Mode on page 1-10

• Reverse Proxy Mode on page 1-10

• ICAP Mode on page 1-10

• Simple Transparency Mode on page 1-10

• WCCP Mode on page 1-11

Transparent Bridge Mode
IWSVA acts as a bridge between network devices such as routers and switches. IWSVA 
scans passing HTTP and FTP traffic without the need to modify the browser or 
network settings. This is the easiest deployment mode with traffic being scanned in both 
directions.

An additional dependency for this deployment mode is two network interface cards per 
transparent bridge segment protected with IWSVA. Trend Micro recommends that the 
following network cards be used to ensure maximum compatibility in this deployment 
mode:

• Broadcom NetXtreme Series

• Intel Pro/1000 PT Dual Port Server Adapter

• Intel Pro/1000 MF Dual Port Fiber

IWSVA 6.5 SP2 features an optional High Availability (HA) deployment mode. In this 
mode, two IWSVA 6.5 SP2 nodes are configured as an HA cluster. In this configuration 
one of the nodes is designated as the parent, or active node, and is connected to a child, 
or passive node, through a “heartbeat” link. 

In HA deployment mode, the parent node processes all “live” traffic while the child 
node remains in a passive state. If a failure in the parent node is detected, the child node 
then becomes the active node and the parent node is taken offline.

The HA deployment mode is only supported in Transparent Bridge mode.

For further details on the Transparent Bridge Mode, see Deploying in Transparent Bridge 
Mode on page 2-33.
1-9
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Forward Proxy Mode
IWSVA acts as an upstream proxy for network clients. Client browser settings must be 
configured to redirect traffic to IWSVA. IWSVA scans HTTP and FTP traffic and there 
is no separate need for another dedicated proxy server. Content is scanned in both the 
inbound and outbound directions.

The Forward Proxy Mode also forwards all traffic to another upstream proxy server.

For more details on the Forward Proxy mode, see Deploying in Forward Proxy Mode on page 
2-10.

Reverse Proxy Mode
IWSVA is deployed in front of a Web server. IWSVA scans HTTP, HTTPS, and FTP 
content from the clients that are uploaded to a Web server as well as content that is 
downloaded from the Web server to the clients and helps secure the Web server.

For more details on the Reverse Proxy Mode, see Deploying in Reverse Proxy Mode on page 
2-29.

ICAP Mode
IWSVA acts as an ICAP proxy and accepts ICAP connections from an ICAP v1.0 
compliant cache server. Cache servers can help reduce the overall bandwidth 
requirements and reduce latency by serving cached content locally. IWSVA scans and 
secures all content returned to the cache server and to the clients.

For more details on the ICAP mode, see Deploying in ICAP Mode on page 2-23.

Simple Transparency Mode
IWSVA's Forward Proxy Mode supports simple transparency with popular Layer 4 load 
balancing switches and provides HTTP scanning without the need to modify the client's 
browser settings.

For more details on the Simple Transparency Mode, see HTTP Proxy in Simple 
Transparency Mode on page 2-16.
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WCCP Mode
IWSVA works with Cisco's WCCP protocol to provide content scanning for Web and 
FTP traffic without the need to modify client configurations and allows redundancy and 
saleability to be designed into the architecture without additional hardware. 

For more details on the WCCP Mode, see Deploying in WCCP Mode on page 2-23.
1-11



Trend Micro™ InterScan™ Web Security Virtual Appliance 6.5 SP2 Installation Guide 
1-12



Chapter 2

Deployment Primer

This chapter describes the following:

• Identifying Your Server Placement on page 2-2

• Planning Network Traffic Flows on page 2-4

• Deploying in Forward Proxy Mode on page 2-10

• Deploying in ICAP Mode on page 2-23

• Deploying in Reverse Proxy Mode on page 2-29

• Deploying in Transparent Bridge Mode on page 2-33
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Identifying Your Server Placement
Before installing InterScan Web Security Virtual Appliance (IWSVA), you will need to 
review the IWSVA deployment modes and decide how to install IWSVA into your 
network environment to best meet your needs. This involves identifying where to place 
the IWSVA server in the network and identifying the best deployment mode for your 
network.

Today's enterprise network topologies typically fall into one of the following two 
categories:

• Two firewalls with a Demilitarized Zone (DMZ) 

• One firewall without a DMZ. 

The ideal location for the IWSVA server depends upon the topology in use.

Two Firewalls with DMZ
Given today's security concerns, many organizations have implemented a topology 
consisting of two firewalls (one external and one internal). These firewalls divide the 
network into two main areas: 

• The DMZ—The DMZ is located between the external and internal firewalls. Hosts 
that reside in this area can accept connections from servers that are external to the 
organization's network. The configuration of the external firewall allows packets 
from external computers to reach only servers inside the DMZ.
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• Corporate LAN—These segments are located behind the internal firewall. The 
configuration of the internal firewall passes traffic to machines on the corporate 
LAN only when the traffic originates from computers inside the DMZ.

FIGURE 2-1.   Two Firewalls with DMZ

This topology requires that all data inbound from the external servers (such as those on 
the Internet) first pass through a server in the DMZ. It also requires that certain types of 
data (for example HTTP and FTP packets), outbound from internal segments, pass 
through a server in the DMZ. This forces the use of proxies such as IWSVA.

One Firewall with No DMZ
Some organizations have a firewall, but no DMZ. When using the “no DMZ” topology, 
place the IWSVA server behind the firewall. 

• Because the IWSVA server is not isolated from the corporate LAN, there is one less 
hop between external machines and machines on the corporate LAN. As shown in 
the diagram, this results in two less steps for processing a request, one outbound 
and one inbound.
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• The firewall configuration allows connections to machines on the corporate LAN. 
For security, the firewall must limit the types of data that can reach machines on the 
LAN. For example, the firewall might allow HTTP data from the Internet to reach 
only the IWSVA server.

FIGURE 2-2.   One Firewall with DMZ

Planning Network Traffic Flows
There are several ways to direct network traffic through IWSVA for protection, 
including the following:

• Reconfiguring client settings to point to IWSVA as a proxy

• Using a Layer 4 switch

• Using an ICAP-enabled proxy to redirect selected traffic for scanning

• Using WCCP to direct selected traffic for scanning

• Forwarding traffic from another proxy and/or caching device

See Appendix A, Deployment Integration starting on page A-1 for more details.

Each network traffic flow configuration has implications for configuring IWSVA, 
configuring the network, and for network security.
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Create a flow plan for the network traffic by doing the following:

• Understand each IWSVA service’s purpose and function

• Determine each service's valid data sources. For example, does the HTTP service 
receive requests directly from the HTTP browsers, or indirectly through an ICAP 
proxy device?

• Determine which ports to use for the service. For instance, by default, the HTTP 
proxy service uses port 8080, and the FTP service uses port 21. However, if another 
application or service is using port 8080, the administrator must configure the 
HTTP proxy service to use a different port.

• Determine each service’s valid data destinations. For example, does the HTTP proxy 
service send validated requests directly to the Web site? Or, does the HTTP proxy 
service send the validated request to an upstream HTTP proxy?

• Add in any service-specific considerations. For instance, the HTTP service flow 
might include an ICAP device, but the FTP service flow does not. 

• If you want IWSVA to see traffic across all ports, ensure that the upstream switch to 
IWSVA is passing all traffic to IWSVA while in Transparent Bridge mode.

Using the information gathered in the previous paragraphs, administrators can 
determine which one of the possible flows is best to use for the installation.

Planning the HTTP Flow
If you are only interested in IWSVA filtering HTTP traffic, then consider the following 
deployment mode options:

• HTTP Proxy

• ICAP device

• WCCP device

• Transparent Bridge

• Simple Transparency 

• Reverse Proxy

The flow involving an ICAP or WCCP device is very different from the flows that do 
not involve ICAP or WCCP devices.
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There are seven possible deployment modes:

Transparent Bridge Settings

• Transparent Bridge mode — Use the transparent bridge mode when clients' 
computers are not configured to use the IWSVA server as their proxy, but still need 
to connect to the Internet through IWSVA. All network traffic, including 
HTTP/HTTPS and FTP, is visible to IWSVA in this mode.

• Transparent Bridge High-Availability (HA) mode — Use this mode when two 
IWSVA devices are configured as a cluster to offer continuous service if one of the 
IWSVA cluster members fails.

Forward Proxy Settings:

• Standalone mode — Use this flow when ICAP devices are not being used with 
IWSVA, and IWSVA connects directly to the Internet. 

• Dependent mode — Use this flow when ICAP devices are not being used with 
IWSVA, and IWSVA cannot connect directly to the Internet, but must instead 
connect through another HTTP proxy. This is can be accomplished in one of the 
following ways:

• Proxy-ahead mode

• Proxy-behind mode (not recommended)

• Double-proxy mode

• Forward Proxy with Transparency — Use this mode when using an L4 (Load 
Balancing) switch.

• WCCP — Use the WCCP protocol in conjunction with WCCP enabled devices 
with IWSVA

Reverse Proxy Settings:

• Reverse proxy mode — Use this flow to protect Web servers with a proxy server 
by placing the HTTP proxy between the Internet and Web servers . (Used by ISPs 
and ASPs to protect the upload traffic against viruses and by organizations with 
complex Web sites that need a centralized point of access control.)

ICAP Proxy Settings:

• ICAP protocol mode — Use the ICAP protocol flow to use ICAP devices with 
IWSVA
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HTTPS Decryption
IWSVA closes the HTTPS security loophole by decrypting and inspecting encrypted 
content for malware and URL access policy violations. You can define policies to 
decrypt HTTPS traffic from selected Web categories. While decrypted, data is treated 
the same way as HTTP traffic to which URL filtering and scanning rules can be applied.

IWSVA supports HTTPS decryption and scanning in the following modes:

• Transparent bridge

• WCCP

• Forward proxy 

Planning FTP Flows
There are two possible FTP flows: standalone and dependent. They are similar to the 
standalone and dependent-mode flows for HTTP service. Each requires a different 
configuration and has its own implications including:

• Standalone—the IWSVA server acts as an FTP proxy server between the 
requesting client and the remote site, brokering all transactions

• Dependent—IWSVA works in conjunction with another FTP proxy server within 
a LAN

FTP Proxy in Standalone Mode
To scan all FTP traffic in and out of the LAN, set up the FTP scanning module so that it 
“brokers” all such connections. In this case, clients FTP to the IWSVA server, supply 
the log on credentials to the target site, and then allow the IWSVA FTP server to make 
the connection. The remote site transfers the files to IWSVA FTP. Before delivering the 
files to the requesting clients, the IWSVA FTP server scans the files for viruses and 
other security risks.

The implications for the FTP standalone flow are:

• IWSVA must have access to the target FTP servers

• There is one less step in the flow, compared to the FTP proxy mode
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To configure FTP clients to use this flow:

• Set the IWSVA server as a FTP proxy

• Set the username to be username@targetftp-server, instead of the normal 
username

Note: IWSVA FTP works with most firewalls, usually requiring only a modification to the 
firewall to open a port for the FTP proxy.

FTP requests follow this sequence:

1. The FTP client sends a request to the IWSVA FTP service.

2. The IWSVA FTP service validates the request (for example, the file type is not 
blocked). If the request is valid, the IWSVA FTP service attempts to connect to the 
appropriate FTP server on the Internet. If the connection succeeds, the IWSVA 
FTP service sends the request to the target FTP server.

3. The FTP server on the Internet responds to the request, ideally with the requested 
file.

4. The IWSVA FTP service scans the returned data for unwanted content. If it finds 
any unwanted content, it returns an appropriate message to the FTP client. 
Otherwise, it returns the requested data to the FTP client. 
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FIGURE 2-3.   FTP Proxy in Standalone Mode

FTP Proxy in Dependent Mode
You can also install IWSVA FTP on a dedicated machine between an upstream proxy 
and the requesting clients. Using this setup adds other FTP features (for example, access 
blocking, logging, and filtering) to supplement the existing FTP proxy.

IWSVA's FTP-proxy mode, shown in Figure 2-4, is analogous to the dependent-mode 
flow of the HTTP service. Because it carries a performance penalty of an extra hop and 
extra processing by the other FTP proxy server, only use this mode if your organization 
does not allow the IWSVA Server to access the Internet directly. 

If the other FTP proxy server uses a store-and-forward technique, the performance 
penalty is more noticeable on large files because the other FTP proxy first downloads 
the file and passes it on to the IWSVA FTP service. Additionally, the other FTP proxy 
must have sufficient free disk space to hold all transfers in progress.

Unlike the HTTP dependent-mode service, which has the possible benefit of cached 
requests, most FTP proxy servers do not cache requests.

FTP Dependent Mode also protects FTP servers from upload and download threats.
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FTP requests follow this sequence:

1. The FTP client sends a request to the IWSVA FTP service.

2. The IWSVA FTP service validates the request (for example, the file type is not 
blocked). If the request is valid, the IWSVA FTP service relays it to the other FTP 
proxy or the FTP server being protected by IWSVA.

3. The FTP server on the Internet responds to the request, ideally with the requested 
file.

4. The IWSVA FTP service scans the returned data for unwanted content. If it finds 
any unwanted content, it returns an appropriate message to the FTP client. 
Otherwise, it returns the requested data to the FTP client.

FIGURE 2-4.   FTP Proxy in Dependent Mode

Deploying in Forward Proxy Mode

Overview of Forward Proxy Mode
There are two kinds of Forward Proxy: transparent and non-transparent. Transparent 
proxy can be achieved by a Layer 4 switch (Simple Transparency) or a WCCP-enabled 
switch (WCCP mode).
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IWSVA configured in forward proxy mode provides the following configuration options 
to enable client protection:

• Reconfiguring Client Settings on page 2-11

• Using a Layer 4 Switch on page 2-12 

• Using a WCCP-enabled Switch or Router on page 2-14

Additionally, when IWSVA is configured in this mode, all traffic can be configured to be 
sent to an additional upstream proxy server if applicable.

The configuration options are explored in the table that follows to provide information 
that will help you decide which deployment configuration to use.

During the IWSVA installation, select to install IWSVA in the Forward Proxy Mode to 
support this configuration.

Reconfiguring Client Settings
HTTP clients (browser or proxy servers) can be configured to contact IWSVA as a proxy. 
This configuration change ensures that the client’s Web traffic is forwarded to IWSVA. 
The HTTP scanning service must be enabled in the HTTP Proxy mode to process this 
traffic.

FTP clients must contact IWSVA instead of the destination server, and use a modified 
handshake to supply the FTP server address. The FTP scanning module must be 
installed and configured in the standalone mode to process this traffic.

TABLE 2-1.   Reconfiguring the Client Settings  

ADVANTAGE LIMITATION

No additional hardware required Administrator have to control the settings 
for all computers. (Guest computers can 
have difficulties.)
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FIGURE 2-5.   Reconfiguring the Client Settings

Using a Layer 4 Switch
Transparency is the functionality whereby client users do not need to change their Internet 
connection’s proxy settings to work in conjunction with IWSVA. Transparency is 
accomplished with a Layer 4 switch that redirects HTTP packets to a proxy server, 
which then forwards the packets to the requested server. 

IWSVA supports the “simple” type transparency. Simple transparency is supported by 
most Layer 4 switches. While it is compatible with a wide variety of network hardware 
from different manufacturers, configuring simple transparency does impose several 
limitations:

• When using simple transparency, the User Identification method to define policies is 
limited to IP addresses and host names; configuring policies based on LDAP is not 
possible.

• FTP over HTTP is not available; therefore, links to ftp:// URLs might not work if 
your firewall settings do not allow for FTP connections. Alternatively, links to ftp:// 
URLs might work, but the files will not be scanned.
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• Simple transparency is not compatible with some older Web browsers when their 
HTTP requests do not include information about the host.

• HTTP requests for servers that use a port other than the HTTP default port 80 are 
redirected to IWSVA. This means SSL (HTTPS) requests are typically fulfilled, but 
the content is not scanned.

• Do not use any source NAT (IP masquerade) downstream of IWSVA, because 
IWSVA needs to know the IP address of the client to clean.

• A DNS server is needed for DCS to resolve the client machine name from its IP 
address in order to perform a cleanup.

A Layer 4 switch can be used to redirect HTTP traffic to IWSVA. The HTTP Scanning 
Service must be enabled in the HTTP Proxy mode. 

FIGURE 2-6.   Using a Layer 4 Switch
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During the installation, ensure that the check box that enables transparency to support 
this deployment mode is checked. 

Using a WCCP-enabled Switch or Router
IWSVA supports WCCP v2.0 and forwarding methods based on GRE and L2 (layer 2).

When using WCCP transparency, FTP downloads are also scanned. With the ability to 
support WCCP v2.0, IWSVA is able to participate in a cluster of IWSVA devices to 
provide a load balancing WCCP Web security platforms.

Advantages of using WCCP:

• Transparency for the client side

• Scalable

Limitations of using WCCP:

• Cisco proprietary

TABLE 2-2.   Using a Layer 4 Switch  

ADVANTAGES LIMITATIONS

Transparent to clients Traffic interception must be port-based 
(not protocol-based) for one port. If the 
non-standard port is used for HTTP, it 
bypasses the switch.

Simple to establish The switch-based redirection cannot be 
used for the FTP traffic.

No LDAP support
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FIGURE 2-7.   IWSVA deployment in a WCCP environment

Planning the HTTP Flow Using the Forward Proxy Mode
For complete details on implementing the Forward Proxy Mode, see Forward Proxy Mode 
on page 1-10.

HTTP Proxy in the Standalone Mode
The simplest configuration is to install IWSVA in standalone mode, with no upstream 
proxy. In this case, IWSVA acts as a proxy server for the clients. Advantages of this 
configuration are its relative simplicity and that there is no need for a separate proxy 
server. A drawback of a forward proxy in standalone mode is that each client must 
configure the IWSVA device as their proxy server in their browser’s Internet connection 
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settings. This requires cooperation from your network users, and also makes it possible 
for users to exempt themselves from your organization’s security policies by 
reconfiguring their Internet connection settings.

Note: If you configure IWSVA to work in standalone mode, each client on your network 
needs to configure their Internet connection settings to use the IWSVA device and 
port (default 8080) as their proxy server.

Web page requests follow this sequence:

1. The Web client sends a request to the HTTP service.

2. The HTTP service validates the request, if the URL is not blocked. If the URL is 
invalid (blocked), the HTTP service sends the HTTP client an appropriate notice, 
completing the transaction. If the URL is valid, the HTTP service attempts to 
connect to the applicable Web server.

3. The contacted Web site returns a response from the Web server to the HTTP 
service.

4. The HTTP service scans the content for unwanted data and returns the appropriate 
response to the client.

HTTP Proxy in Simple Transparency Mode 
Multiple IWSVA servers can be installed to balance your network traffic and scanning 
load. In this installation example, a Layer 4 switch receives clients requests and then 
forwards them to the IWSVA servers.

TABLE 2-3.   HTTP Proxy in Standalone Mode  

ADVANTAGE LIMITATION

Simple to install and deploy. Slow connection reaches maximum 
allowed connections limit.

Each client on the network must config-
ure their proxy server.
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FIGURE 2-8.   Use a Layer 4 switch to load balance between IWSVA servers 
in simple transparent mode

HTTP Proxy in Dependent Mode (Proxy Ahead)
For HTTP browsers to use this flow, configure the browsers to proxy through the 
IWSVA server, by default at port 8080.
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HTTP Proxy in Dependent Mode (Proxy Ahead

Web page requests follow this sequence:

1. The Web client sends a request to the HTTP service.

2. The HTTP service validates the request. 

• If the URL is invalid (blocked), the HTTP service sends the HTTP client an 
appropriate notice, completing the transaction. 

• If the URL is valid, the HTTP service forwards the request to an upstream 
HTTP proxy server. 

3. The upstream proxy server performs its processing, then forwards the request to 
the Web site on the Internet.

4. The contacted Web site returns a response (ideally a Web page) to the HTTP proxy 
server. 

5. The HTTP proxy server performs its processing on the returned data, then 
forwards the response data to the IWSVA HTTP service. 
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6. The HTTP service scans the content for unwanted data and returns an appropriate 
response to the HTTP client.

HTTP Proxy in Dependent Mode (Proxy Behind)
The proxy behind flow consists of a caching proxy placed between the HTTP client and 
the IWSVA server without using ICAP. Organizations typically use this flow to increase 
performance, as with ICAP. 

WARNING! Two security trade-offs exist for this potential performance enhancement: 
 
1. If the cache contains data with a virus, for which there was no pattern 
when the data hit the cache, the IWSVA HTTP service cannot prevent the 
spread of the virus.  
 
2. Similarly, if a policy regarding valid content changes, or unauthorized 
users request data that exists in the cache (for authorized users), the 
HTTP service cannot prevent subsequent unauthorized access to this 
data.

Instead of using the proxy-behind flow, Trend Micro recommends that administrators 
use an ICAP caching device. This solution provides the performance enhancements of 
caching without the security issues of proxy-behind topology.

TABLE 2-4.   HTTP Proxy in Dependent Mode (Proxy Ahead)  

ADVANTAGES LIMITATIONS

Proxy server controls timing and content 
availability behavior.

IWSVA has to scan every 
response-even when cached. 

It is more secure—configuration changes 
will affect cached objects.

IWSVA does not wait for the downloading 
of already cached objects.
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Web page requests follow this sequence:

1. The Web client sends a request to the HTTP proxy server.

2. The proxy server forwards the request to IWSVA.

3. IWSVA validates the request using URL Filtering/URL Access Control:

• If the URL is invalid (blocked), the HTTP service sends the HTTP client an 
appropriate notice, completing the transaction. 

• If the URL is valid, the HTTP service forwards the request to the Web server 
on the Internet. 

4. The contacted Web server returns a response (ideally a Web page) to IWSVA. 

5. IWSVA performs its processing on the returned data (virus, spyware, ActiveX 
scanning), then forwards the appropriate response/data to the proxy server. 

6. The Proxy server caches the data (if cacheable), then delivers the response/data to 
the HTTP client.

FIGURE 2-9.   HTTP Proxy in Dependent Mode (Proxy Behind)

TABLE 2-5.   HTTP Proxy in Dependent Mode (Proxy Behind)  

ADVANTAGES LIMITATIONS

No configuration changes required 
on the clients.

Configuration changes or pattern 
updates on IWSVA do not affect cached 
objects.
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HTTP Double Proxy in Dependent Mode
Double proxy configuration requires two caching proxies. The first proxy is placed 
between the HTTP client and the IWSVA server, and other one is placed between the 
IWSVA server and the Internet. This is typically used to get the advantages of the two 
configurations of the dependent modes: Proxy-ahead and Proxy-behind.

Web page requests follow this sequence:

1. The Web client sends a request to the first proxy server.

2. The first proxy server forwards the request to IWSVA.

3. IWSVA validates the request using URL Filtering/URL Access Control: 

• If the URL is invalid (blocked) the HTTP service sends the HTTP client an 
appropriate notice, completing the transaction. 

• If the URL is valid, the HTTP service forwards the request to the second proxy 
server. 

4. The second proxy server performs its processing, then forwards the request to the 
Web server on the Internet.

5. The contacted Web server returns a response (ideally a Web page) to second proxy 
server. 

6. The second proxy server caches the data (if cacheable), then delivers the 
response/data to IWSVA.

7. IWSVA performs its processing on the returned data (Virus, Spyware, ActiveX 
scanning), then forwards the appropriate response/data to the first proxy server. 

Cached objects are downloaded by 
clients directly from the Proxy 
server, which minimizes delays.

TABLE 2-5.   HTTP Proxy in Dependent Mode (Proxy Behind)  (Continued)

ADVANTAGES LIMITATIONS
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8. The first proxy server caches the data (if cacheable), then delivers the response/data 
to the HTTP client.

FIGURE 2-10.   HTTP Double Proxy in Dependent Mode

TABLE 2-6.   HTTP Double Proxy in Dependent Mode 

ADVANTAGES LIMITATIONS

Proxy server controls timing and con-
tent availability behavior.

Costs more—additional proxy servers 
are needed.

IWSVA does not wait for the down-
loading of already cached objects.

No configuration change required on 
the clients.
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Deploying in WCCP Mode

Note: For advanced information on deploying in WCCP mode, see the IWSVA 6.5 SP2 
Administrator's Guide, “Appendix F, WCCP Deployment & Troubleshooting.”

HTTP Proxy in WCCP Mode (Single and Multiple IWSVA 
Servers)
IWSVA configured in the WCCP Mode processes Web page requests in the following 
sequence:

1. The Web client sends a request to the Web server.

2. The router intercepts the request and forwards the request to IWSVA. 

3. IWSVA establishes a connection with the Web client.

4. IWSVA forwards the client requests to the Web server and establishes a connection 
with the Web server.

5. IWSVA begins sending data between the Web client and the Web server.

6. If the data has no virus, then IWSVA sends the data to the Web client.

7. If the data has a virus, then IWSVA sends the blocked page to the Web client.

Deploying in ICAP Mode

Overview of ICAP Mode
Internet Content Adaptation Protocol (ICAP) is designed to forward an HTTP 
response or request to third-party processors and collect the results. The component 
that sends the ICAP request is called the ICAP-client. A component that processes the 
request is called an ICAP-server.

When IWSVA is configured in ICAP mode, it processes requests from any 
ICAP-compliant client. Officially, Trend Micro supports the following ICAP version 1.0 
implementations: NetCache, Blue Coat, Cisco Content Engines (CE), and Squid. 
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IWSVA 6.5 SP2 supports secure ICAP communication between an ICAP-compliant client 
that includes the ICAP over SSL feature. To enable secure ICAP communication, use 
the Deployment Wizard on IWSVA to import the server certificate and configure 
related settings. 

FIGURE 2-11.   Using an ICAP-enabled Proxy

TABLE 2-7.   ICAP-enabled Proxy 

ADVANTAGES LIMITATIONS

ICAP allows scanning of only new and 
necessary content.

Up front cost of ICAP equipment.

Reduced and selective scanning 
enhances performance

Adds extra steps in the IWSVA instal-
lation process.

Increased resource efficiencies 
reduce the number of IWSVA server 
hardware needed.

Requires management.
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Planning the HTTP Flow Using the ICAP Mode
For complete details on implementing the ICAP Mode, see ICAP Mode on page 1-10.

HTTP Proxy in ICAP Mode (Single and Multiple IWSVA 
Servers)
This section discusses the flow of a typical HTTP GET request using both an ICAP 
device and IWSVA servers. In these flows, IWSVA interacts with the ICAP device, in 
response to ICAP rules. This is very different from other flows where IWSVA receives 
URL requests from HTTP clients. To use these flows for HTTP browsers, configure the 
browsers to use the ICAP device as the HTTP proxy.

Using ICAP devices can enhance performance in two ways:

• Caching good data—If the data is clean, the ICAP device caches the data. 
Subsequent requests require only four steps, not eight. (ICAP must still ask IWSVA 
to check the policies to validate that the users making the subsequent requests can 
browse the data, have not exceeded their quota, and so on.)

• Clustered IWSVA servers—When multiple IWSVA servers are used, the ICAP 
device load balances the requests between the servers. This is vital for enterprise 
environments where the demand for scanning incoming pages can overwhelm a 
single IWSVA server. With ICAP, the ICAP device performs load balancing, and 
receives maximum performance from the available IWSVA servers.

Note: Non-ICAP environments can receive similar benefits by using multiple IWSVA 
servers. However, the administrator must utilize additional load balancing technology.

When IWSVA is configured in ICAP mode, it processes requests from any 
ICAP-compliant client. Trend Micro supports the following ICAP client 
implementations:

• NetCache

• Blue Coat

• Cisco Content Engines

• Squid
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Although IWSVA performs the same filtering of URLs and scanning of data for 
unwanted content, the ICAP flow is so different from the other flows that it requires a 
completely different communications protocol. Administrators indicate which protocol 
(ICAP or non-ICAP) to use during post-installation configuration. 

The figures that follow show the HTTP flow with single and multiple IWSVA servers. 
(Both images assume the requested data is not in the ICAP device's cache.) The ICAP 
service determines which IWSVA server receives the request in a multi-server 
environment. 

IWSVA configured in ICAP Mode processes Web page requests in the following 
sequence:

1. An HTTP client makes a request for a URL, sending the request to the ICAP 
caching proxy device.

2. The ICAP device, based on its configuration, determines that the request must be 
forwarded to an IWSVA server. If multiple servers are available, it alternates in 
round-robin fashion for load balancing.

3. The IWSVA server validates the URL.

• If the URL is not blocked, IWSVA sends the response to the ICAP device. 

• If the URL is invalid (blocked), IWSVA directs the ICAP device to send an 
appropriate response to the HTTP client and the transaction is complete.

4. If the URL is valid, the ICAP server requests the page from the Web site on the 
Internet.

5. The Web site on the Internet returns the requested page (or some other appropriate 
response). 

6. If the page is returned, the ICAP device, based on its configuration, determines that 
an IWSVA server must scan the data. Again, if multiple servers are available, it 
alternates in round-robin fashion for load balancing.

7. The IWSVA server scans the results and returns an appropriate response to the 
ICAP device, based on whether the data is clean or contains unwanted content. 

8. If the data is clean, the ICAP device returns said data to the HTTP client, and the 
ICAP device retains a copy of the data to satisfy future requests. If the data contains 
unwanted content, the ICAP device returns an appropriate error message (dictated 
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by IWSVA) to the HTTP client, and the ICAP device does not retain a copy for 
future requests.

FIGURE 2-12.   HTTP Proxy in ICAP Mode (Single IWSVA Server)

IWSVA ICAP Mode with Multiple Servers
If there is already a content cache server on your network, then Trend Micro 
recommends installing the ICAP HTTP handler. The following diagram shows the 
installation topology for IWSVA ICAP with multiple servers. For multiple IWSVA ICAP 
servers to work properly, their corresponding pattern, scan engine version, and 
intscan.ini files must be identical.
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FIGURE 2-13.   HTTP Proxy in ICAP Mode (Multiple IWSVA Servers)

TABLE 2-8.   HTTP Proxy in ICAP Mode  

ADVANTAGES LIMITATIONS

No configuration changes required on 
the clients.

Configuration changes on IWSVA 
affects cached objects.

Cached objects are downloaded by cli-
ents directly from the Proxy server, 
which minimizes delays, and improves 
performance.

Load-balancing is possible after some 
configuration to the clients.
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Deploying in Reverse Proxy Mode

Overview of Reverse Proxy Mode
IWSVA is usually installed close to clients to protect them from security risks from the 
Internet. However, IWSVA also supports being installed as a reverse proxy to protect 
Web servers from having malicious programs uploaded to it. In Reverse Proxy Mode, 
IWSVA is installed close to the Web server that it protects. In this mode, IWSVA 
protects Web servers with the proxy server. The HTTP proxy is placed between the 
Internet and the Web server. This is useful when the Web server accepts file uploads 
from clients, or to reduce the load of each Web server by balancing the load among 
multiple Web servers. When IWSVA is used to protect multiple Web servers with load 
balancing, communication between the clients and Web servers is in HTTP. ASPs/ISPs 
can use IWSVA as an HTTP proxy to protect the upload traffic against viruses, and 
organizations with complex Web sites need it as a centralized point of access control. 

IWSVA receives clients requests, scans all content and then redirects the HTTP requests 
to the real Web server. This flow is especially useful for Web sites involved in 
e-commerce transactions, distributed applications that exchange data across the 
Internet, or other situations where clients upload files to the Web server from remote 
locations.

In Reverse Proxy Mode, you can set IWSVA to listen for incoming requests on the SSL 
port. To enable this feature, import the server certificate using the Deployment Wizard 
in the IWSVA Web console and configure the related settings. 
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FIGURE 2-14.   Reverse proxy protects Web server from clients

Planning the HTTP Flow Using Reverse Proxy Mode
For complete details on implementing the Reverse Proxy Mode, see Reverse Proxy Mode on 
page 1-10.

HTTP Reverse Proxy in Dependent Mode
In reverse proxy mode, the HTTP proxy acts as the Web server to the client systems. 
The proxy receives all requests and transfers them to the real Web server. Consequently, 
all HTTP traffic goes through the HTTP proxy, enabling the proxy to scan the content 
and block any infected transactions.
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Note: Administrators should be aware of the following: 
- The URL-filtering feature makes no sense in this configuration; only antivirus 
scanning is useful. 
- In the reverse proxy mode, the Web server's access log is useless. To analyze the 
connections for the Web site, you must use the IWSVA access log. 
- Ideally, the reverse proxy server should be placed behind a firewall, but in many 
cases, the proxy is connected directly to the Internet, where it is more vulnerable to 
direct attacks. When a reverse proxy is configured without a firewall, administrators 
should take all appropriate precautions in securing the operating system hosting 
IWSVA.

IWSVA configured in Reverse Proxy Mode processes Web page requests in the 
following sequence:

1. Clients initiate the Web request.

2. The request is received by Trend Micro™ InterScan™ Web Security Virtual 
Appliance, and configured to listen on port 80 or 443.

3. Trend Micro™ InterScan™ Web Security Virtual Appliance scans the content, then 
forwards it to an actual Web server.

4. The Web server delivers the requested page back to IWSVA.

5. Trend Micro™ InterScan™ Web Security Virtual Appliance rewrites the page 
headers, and sends on the request.
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6. The modified page returns to the requestor.

FIGURE 2-15.   HTTP Reverse Proxy in Dependent Mode

TABLE 2-9.   More About HTTP Reverse Proxy in Dependent Mode  

ADVANTAGES LIMITATIONS

IWSVA scans all objects before they 
are cached.

New engines, patterns, and configura-
tions will not affect cached objects.

The access logging feature of IWSVA 
is compromised.
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Deploying in Transparent Bridge Mode

Overview of Transparent Bridge Mode
In the Transparent Bridge Mode, IWSVA acts as a bridge between two network devices 
(switch, router, or firewall) and transparently scans HTTP/HTTPS and FTP traffic. 
Transparent Bridge Mode is the simplest way to deploy IWSVA into an existing network 
topology and does not require modifications to clients, routers, or switches. IWSVA acts 
as a “bump in the wire” and scans for malware. Two network cards are required for 
IWSVA to be configured in Transparent Bridge Mode.

The benefit of the Transparent Bridge Mode is that client’s HTTP/HTTPS requests can 
be processed and scanned by IWSVA without any client configuration changes. This is 
more convenient for your end users, and prevents clients from exempting themselves 
from security policies by simply changing their Internet connection settings.

Another important benefit of this deployment mode is that IWSVA sees all traffic across 
all ports. This enables utilization of the Application Control feature of IWSVA to 
monitor and control not only HTTP/HTTPS and FTP, but over 420 other applications 
and protocols.

FIGURE 2-16.   Typical bridge mode deployment
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Note: Silicom bypass cards are recognized by VMware ESXi 5.0, but they can only be used 
as NORMAL network cards without the bypass function.

Planning the HTTP Flow Using Transparent Bridge Mode
For complete details on implementing the Forward Proxy Mode, see Transparent Bridge 
Mode on page 1-9.

IWSVA configured in Transparent Bridge Mode processes Web page requests in the 
following sequence:

1. The Web client sends a request to the Web server.

2. IWSVA accepts the connection from client and sends the request to the Web server. 

3. IWSVA establishes a connection with the Web client.

4. IWSVA establishes the connection with the Web server and gets data from the Web 
server.

5. If the data contains no viruses, then IWSVA sends the data to the Web client.

6. If the data contains a virus, then IWSVA sends the blocked page to the Web client.

High Availability Deployment Mode
IWSVA 6.5 SP2 Transparent Bridge mode supports deployment in High Availability 
(HA) mode where two IWSVA 6.5 SP2 nodes are configured as an HA cluster. In this 
configuration one of the nodes is designated as the parent, or active node, and is 
connected to a child, or passive node, through a “heartbeat” link.

For HA mode deployments, it is recommended to perform a bare metal installation of 
each IWSVA 6.5 SP2 HA cluster member. This avoids the situation where both HA 
cluster members are installed in a virtual server and the virtual server becomes 
inoperable. In this situation, both members of the HA cluster will also become 
inoperable.
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Note: The HA deployment mode is only supported in Transparent Bridge mode. High 
Availability among multiple IWSVAs deployed in the other supported deployment 
modes is handled externally to the IWSVA instance. Specifically, load balancers 
support redundancy in any of the proxy modes. The Cisco WCCP device can manage 
traffic to redundant IWSVAs in WCCP mode. The ICAP proxy client can manage 
traffic to redundant IWSVAs in ICAP mode.

FIGURE 2-17.   High Availability Deployment Mode

HA Deployment Mode Installation Guidelines
When IWSVA is initially installed, a static IP address is assigned to the selected network 
interface on each of the IWSVA units participating in the HA cluster.

To successfully configure the HA feature, you will need to know which network card 
(eth0, eth1, and so on) was assigned the IP address during the installation process and 
how the network interfaces are configured on the server. IWSVA provides a CLI 
command to simplify the gathering of this information and by executing this CLI 
command after the initial installation of IWSVA, you can gather and record the 
necessary information to complete the installation with the Web console.

After the CLI command is used to gather the necessary information, you can connect to 
the Web console through your browser. For new installations, the Deployment Wizard 
will automatically start and guide you through the deployment modes.

To avoid creating a network loop, be sure to configure each of the IWSVA units as a 
Forward Proxy device first. Once all of the network information is configured, the 
deployment wizard can be used to create the HA cluster. 
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WARNING! If you accidentally configure both IWSVA devices as parent or active 
devices in transparent bridge mode, a network loop can be created. To 
avoid this possibility, please configure each IWSVA as a forward proxy 
device before configuring the HA feature.

To configure an IWSVA HA cluster:

1. Install two IWSVA devices in forward proxy mode. One will become the parent 
active device and the other will become the child passive device.

2. Because IWSVA devices can be installed on generic server hardware, you will need 
to confirm the network card and network information prior to setting up the HA 
cluster. Gather the network card information that will be used in the Web UI 
configuration steps to finalize the HA cluster configuration. This is performed by 
logging into the IWSVA's CLI console and executing the following CLI command:

show network interface status

3. Make sure both IWSVA devices are connected to the network using the active 
network card identified in the previous step. Both IWSVA units must be able to 
communicate with each other and the management host that will be used to 
configure the HA cluster.

4. From your management host, use the browser to connect to the IWSVA device that 
is to act as the parent or active member. If this is the first time you've accessed the 
IWSVA's Web console after the initial installation, the Deployment Wizard will start 
automatically. You can also access it from the Administration > Deployment 
Wizard menu option.

5. Follow the on-screen instructions in the Deployment Wizard to configure the first 
HA cluster member. This will be the parent or active unit.

6. Repeat steps 4 and 5 for the IWSVA device that will be the child member. The child 
member will join the parent member to complete the HA cluster. 

Please refer to Chapter 3, High Availability and Cluster Management in the IWSVA 
Administrator’s Guide for details about creating HA clusters.
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Chapter 3

Installing InterScan Web Security 
Virtual Appliance

This chapter explains the following:

• Obtaining IWSVA on page 3-2

• Installing IWSVA on page 3-4

• Logging in to IWSVA for the First Time on page 3-11

• Post-Installation Notes on page 3-11
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Obtaining IWSVA
IWSVA is supported on the following platforms:

• Bare Metal installation (dedicated off-the-shelf server platform without an operating 
system). Refer to the list of current certified hardware platforms to ensure your 
preferred server platform is supported by IWSVA. This list can be found at the 
following location:

http://us.trendmicro.com/imperia/md/content/us/pdf/partners
/certifiedbytrendmicro/trendtested_hw_matrix_mar2011.pdf

• VMware ESXi 5.1/5.5 as a virtual machine

• Microsoft Hyper-V 3.0 installed as a virtual server on Windows Server 2012 R2 or 
later version

For information regarding server requirements for IWSVA, refer to Server Requirements on 
page 1-2.

Trend Micro recommends that you evaluate the method of installation that best suits 
your environment.

You can install IWSVA from the Trend Micro Enterprise Solutions DVD or download 
the installation ISO from the Trend Micro IWSVA download location:

http://downloadcenter.trendmicro.com/

The DVD is available to purchase and contains the installation files and all 
documentation.

Using the Trend Micro Enterprise Solutions DVD
To complete this installation, you need to create a bootable installation DVD that 
contains the IWSVA ISO file.

Procedure:

1. To create the installation media, insert the Trend Micro Enterprise Solution disk 
into the DVD drive on the computer where ISO images can be created.

2. Copy the IWSVA ISO image from the Trend Micro Enterprise Solutions Media 
onto the local hard drive.
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3. Eject the Enterprise Solutions DVD and place a blank DVD disk into the DVD 
writer.

4. Burn the IWSVA ISO image to the blank DVD.

5. Insert the newly created IWSVA Installation DVD into the target server where you 
would like to install IWSVA.

6. Reboot the server and boot from the IWSVA installation DVD to begin the 
installation process.

Note: The file on the Enterprise DVD and on the Trend Micro Evaluation site is an ISO 
image. The ISO image allows you to create an IWSVA installation DVD to install the 
product.

Downloading the Installation File
Procedure:

1. Go to the Trend Micro download Web page:

http://downloadcenter.trendmicro.com/

2. Download the IWSVA ISO file.

3. Burn the IWSVA ISO image to the blank DVD.

4. Insert the newly created IWSVA Installation DVD into the target server where you 
would like to install the IWSVA application.

WARNING!  IWSVA does not support installation using an external USB DVD 
drive. 

5. Reboot the server and boot from the IWSVA installation DVD to begin the 
installation process.

Note: The ISO image needs to be copied and then burned onto a blank DVD in order to 
create the IWSVA installation DVD (See the DVD ISO creation document, How to 
Use the Trend Micro IWSVA ISO File.)
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Installing IWSVA
IWSVA only supports new installations or migrations from specific versions.

IWSVA supports migrating existing configuration and policy data from IWSVA 6.5 and 
IWSVA 6.5 SP1 products (see Migration on page 1-6).

The IWSVA installation process formats your existing system to install IWSVA. The 
installation procedure is basically the same for the Bare Metal and the VMware ESX 
Hyper-V virtual machine platforms. The Bare Metal installation simply boots off of the 
IWSVA installation DVD to begin the procedure. The VMware and Hyper-V 
installations require the creation of a virtual machine before installation. Additional 
VMware virtual machine configuration is described in Appendix E, Creating a New 
Virtual Machine Under VMware ESX for IWSVA on page E-1. Additional Hyper-V virtual 
machine configuration is described in Appendix F, Creating a New Virtual Machine Under 
Microsoft Hyper-V for IWSVA on page F-1.

WARNING! Any existing data or partitions are removed during the installation pro-
cess. Backup any existing data on the system (if any) before installing 
IWSVA.

IWSVA also installs a copy of the open source content caching application called Apache 
Traffic Server (ATS). It is disabled by default but you can enable this free open-source 
utility through the IWSVA administration Web UI. Trend Micro provides ATS content 
caching for convenient and easy installation. Support for ATS is provided by the ATS 
open-source community.

Trend Micro Disclaimer: Trend Micro IWSVA preinstalls Apache Traffic Server (ATS) 
and provides the basic configuration and statistical reports to 
help reduce the complexity of installing and configuring ATS to 
function with IWSVA. ATS is disabled by default and must be 
enabled through the IWSVA Web console after installation has 
been completed. Support for ATS is obtained through open 
source channels and it is the responsibility of the customer to 
become acquainted with ATS's benefits and functionality before 
enabling.  
 
Additional information, documentation, and support on the ATS 
application can be found at the official ATS Web Proxy Cache 
3-4



Installing InterScan Web Security Virtual Appliance
Web site: www.trafficserver.apache.org.  
 
Trend Micro will not provide support for ATS features, but will 
provide support for the setup and integration of ATS and 
IWSVA through its supplied configuration commands.

To install IWSVA:

1. Start the IWSVA installation. 

Installing on a Microsoft Hyper-V Virtual Machine

a. Create a virtual machine on your Microsoft Hyper-V server.

See Appendix F, Creating a New Virtual Machine Under Microsoft Hyper-V 
for IWSVA on page F-1.

b. Refer to Post Installation Notes to access the IWSVA Web console and 
continue IWSVA configuration.

Installing on a Bare Metal Server

Insert the IWSVA Installation DVD (which was created from the IWSVA ISO image) 
into the DVD drive of the desired server.

Note: Because IWSVA does not support external USB CD/DVD drives, a “Cannot 
find kickstart file on DVD-ROM” warning message displays when installing 
IWSVA. You can safely ignore this warning message. 

Installing on a VMware ESX Virtual Machine

a. Create a virtual machine on your VMware ESX server.

See Appendix E, Creating a New Virtual Machine Under VMware ESX for 
IWSVA on page E-1.

b. Power on the virtual machine that was created to boot from the IWSVA 
installation ISO.

Note: If your computer boots from an ISO image (such as ISOLINUX), you need to press 
[ENTER] at the bootloader prompt to continue with the IWSVA installation process.
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Installation Steps for both a VMware ESX Virtual Machine and a Bare Metal 
Server

Note: IWSVA does not need a network connection during installation, but it must connect 
with the Internet when using the Deployment Wizard after the installation completes.

A page appears displaying the IWSVA Installation Menu. The options on this menu 
are as follows:

• Install IWSVA: Select this option to install IWSVA onto the new hardware or 
virtual machine.

• System Recovery: Select this option to recover an IWSVA system in the event 
that the administrative passwords cannot be recovered.

• Exit Installation: Select this option to exit the installation process and to boot 
from the local disk.

2. Select Install IWSVA.

The license acceptance page appears.

3. Click Accept to continue. 

A page appears where you choose a keyboard language.

4. Select the keyboard language for the system and then click Next.

5. Select the driver(s) used for installation and then click Next.

The IWSVA installer scans your hardware to determine if the minimum 
specifications have been met and then displays the results illustrated as follows. If 
the host hardware contains any components that do not meet the minimum 
specifications, the installation program highlights the nonconforming components 
and the installation stops.

6. Click Next to continue. 

A page appears where you specify network devices, hostname, and miscellaneous 
settings. If you choose to set the hostname manually, the Miscellaneous Settings will 
be available to you. 
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Note: You must assign a valid hostname to the IWSVA server for it to function 
properly. 
 
The IWSVA hostname must be entered into the DNS server assigned to the 
IWSVA and its users.

7. Select the network devices and input the corresponding IP addresses. 

Note: After installing the IWSVA OS, you can access the IWSVA Web console using 
the NIC you select, then run the Deployment Wizard to complete the necessary 
configuration. Also, you can use the Deployment Wizard to change the existing 
network settings. 

FIGURE 3-1.   Page to specify network devices, hostname, and 
miscellaneous settings

8. Configure the network settings as required for IWSVA and then click Next.

9. Specify the time zone for IWSVA on the time zone page. 
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Use the drop-down list to display the supported time zones or point to your 
location using the time zone map. 

10. Click Next.

11. Specify a password for the administrator account.

IWSVA uses three different levels of administrator types to secure the system: Root 
account, Enable account, and Admin account. For convenience, the passwords for 
these three accounts are set the same in this step. You can change each password 
separately after installation.

Root Account: The Root account is used to gain access to the operating system 
shell and has all rights to the server. This is the most powerful account on the 
system.

Enable Account: The Enable account is used to gain access to the command line 
interface’s (CLI) privilege mode. It has all rights to execute CLI commands.

Admin Account: The Admin account is the default administration account used in 
the IWSVA Web console and CLI management interface. It has all rights to the 
IWSVA application, but no access rights to the operating system shell. The default 
username is “admin”.

As you type the passwords, the password strength meter on the right indicates how 
strong the selected password is. For the best security, Trend Micro recommends 
using a strong, unique password.

12. Click Next.

A page appears where you accept all the configuration settings. 

13. Confirm that the selected values are correct and then click Next.

The installation process prompts you to begin the installation. Selecting Continue 
erases any data on the hard disk partition and formats the hard disk. If you have 
data on the hard disks that you would like to keep, cancel the installation and 
backup the information before proceeding.

14. Click Continue.

A page appears that provides the formatting status of the local drive for the IWSVA 
installation. When formatting completes, the IWSVA installation begins.
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FIGURE 3-2.   Summary screen contains default password.

After the installation is complete a summary screen appears. The installation log is 
saved in the /root/install.log file for reference.

15. Click Reboot to restart the system.

• For a bare metal installation: The DVD automatically ejects. Remove the 
DVD from the drive to prevent reinstallation.

• For a virtual machine installation: Trend Micro recommends disconnecting 
the DVD-ROM device from the virtual machine now that IWSVA is installed.

After IWSVA reboots, the initial CLI log in screen appears. (See Figure 3-3.)
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FIGURE 3-3.   The initial CLI log in screen

Note: During installation, you might receive the following messages: 
 
for crash kernel (0x0 to 0x0) not within permissible range 
powernow-k8: bios error -no psb or acpi_pss objects 
 
Both of these messages are normal. The latter message indicates that the system BIOS 
is not reporting or presenting any PSB or ACPI objects or hooks to the Linux kernel. 
Either the CPU or BIOS does not support PSB or ACPI objects or hooks or they are 
simply disabled.

16. Prepare to log into the IWSVA Web console by disabling the pop-up blocker in 
your browser. 

Note: Pop-up blockers block the Change Password dialog box and the Deployment 
Wizard which are launched during the first-time login.

17. Log in to the IWSVA Web console to launch IWSVA. 

See Logging in to IWSVA for the First Time on page 3-11 for details.
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Logging in to IWSVA for the First Time
After IWSVA has restarted, you can log in to the appliance either through the CLI or the 
Web management interface.

• For the CLI interface, type in your administrator username and password at the 
console login prompt.

Note: Turn off the pop-up blocker in your browser before logging into the Web 
console for the first time. Pop-up blockers block the Change Password dialog 
box and the Deployment Wizard.

• For the Web management interface, on your workstation (not IWSVA) open a new 
Web browser and then type in the URL (https://<IWSVA 6.5 SP2 IP 
Address>:8443) indicated in the initial CLI banner. You will need the IWSVA 
administrator account and password to log in. The administrator account name is 
“admin” and the password is set by the user during installation.

Post-Installation Notes
After the initial CLI is available:

• The Deployment Wizard launches when you first log into the Web console. Use the 
Deployment Wizard to complete your installation. (See the Administrator’s Guide, 
Chapter 2.)

• Trend Micro recommends that you update your scan engine and virus pattern files 
immediately after registering and activating the product. (See the Administrator’s 
Guide, Chapter 3.)
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Chapter 4

Migrating to InterScan Web Security 
Virtual Appliance

This chapter describes the following: 

• About Migration on page 4-2

• Information Not Migrated on page 4-3

• Migrating from IWSVA 6.5 or 6.5 SP1 to IWSVA 6.5 SP2 on page 4-5

• Migrating from IWSVA 6.5 SP2 to Another IWSVA 6.5 SP2 on page 4-6

• After Migrating on page 4-7
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About Migration
InterScan Web Security Virtual Appliance (IWSVA) 6.5 SP2 supports both full and 
partial migration. Use full migration to restore the system and application settings or to 
apply current configuration to an IWSVA replacement machine. Perform a partial 
migration if you want to replace policy and application level configurations. 

WARNING! IWSVA 6.5 SP2 only supports migration from the SAME language ver-
sions of IWSVA. 
 
Before you perform a full migration, make sure the hardware configura-
tion and deployment mode are the same on both the source and target 
IWSVA 6.5 SP2 machines.  
 
Trend Micro recommends that you configure the target IWSVA 6.5 SP2 
machine to use the same IP address as in the backup configuration file 
(exported from the source IWSVA 6.5 SP2 machine) to prevent unex-
pected behavior after a full migration.  
 
Do NOT connect both IWSVA 6.5 SP2 machines to the network simulta-
neously. Only one IWSVA 6.5 SP2 machine should be connected at a time. 

The configuration and policy information for the following IWSVA products can be 
migrated to IWSVA:

• IWSVA 6.5

• IWSVA 6.5 SP1

Important Notes
• You can export IWSVA configuration to a backup file. Export information includes 

both system level and application level configuration settings. 

• Use the Config Backup & Restore page in the Web console to import the backup 
file containing the IWSVA 6.5 SP2 configuration. A screen displays to prompt you 
to select either full migration or partial migration. 

• Password information in a configuration backup file will not be displayed in clear 
text. 

• IWSVA records a configuration import or export action in the audit log. 
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Information Not Migrated
The following lists the items that are not migrated. 

Full Migration

• Logs stored in databases, reports, messages, and quarantined files 

• Pattern and engine files and related version information located in configuration 
files 

• Database passwords

• Product activation code

• OS and application patches

• All configuration settings under the Administration menu in the Web console except 
the following settings:

• User Identification                         

• Policy Deployment                           

• Quarantine Management (If it is in the same directory as the source server) 

• System Time                                 

• Scheduled Time                                        

• PAC Files Management

• Network Configuration 

• Scan Method

Partial Migration

• Logs stored in databases, reports, messages, and quarantined files 

• Pattern and engine files and related version information located in configuration 
files 

• Database passwords and configurations

• Product activation code

• Deployment mode configurations

• (For partial IWSVA 6.5 SP2 to IWSVA 6.5 SP2 migration) System level settings such 
as IP address, hostname, and so on

• OS and application patches
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• All configuration settings under the Administration menu in the Web console except 
the following settings:

• User Identification   

• Policy Deployment 

• Scheduled Time 

Overview of the Migration Process
This procedure lists the major steps for both full and partial migration.

Procedure: 

1. Back up previous IWSVA settings.

2. Install IWSVA 6.5 SP2.

3. Import the previously backed up configuration file to the new IWSVA machine. If 
you are migrating from a source IWSVA to a target IWSVA 6.5 SP2, and both 
devices are configured in standalone mode, you can choose to perform a full or 
partial migration. Otherwise, by default, only a partial migration is performed.

4. You can access the Web console to configure new IWSVA 6.5 SP2 features. 

Note: After the migration process completes, the default settings imported for IWSVA 6.5 
SP2 features will apply. 
 
For a list of settings that are not migrated, refer to Information Not Migrated on page 
4-3. 
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Migrating from IWSVA 6.5 or 6.5 SP1 to IWSVA 
6.5 SP2

Note: IWSVA 6.5 SP2 only supports partial migration if you want to restore back to a 
previous backup IWSVA 6.5 or 6.5 SP1 configuration.  
 
IWSVA 6.5 SP2 supports migration ONLY from same language version.

Procedure:

1. Open the Web console of the source IWSVA; then, select Administration > 
Configuration Backup & Restore, and then click Export.

The screen displays a progress bar. When the export process is finished, a result 
page displays the status. If configuration export is successful, IWSVA opens a 
dialog box to prompt you to save the configuration file to a local disk. Save the file 
to a local drive on your computer.

2. Open the Web console of the target IWSVA 6.5 SP2 machine and then select 
Administration > Configuration Backup & Restore from the main menu.

3. Click Browse to select a backup file and then click Import.
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Migrating from IWSVA 6.5 SP2 to Another 
IWSVA 6.5 SP2

Note: IWSVA 6.5 SP2 does not support migration from another language version of IWSVA 
6.5 SP2. 
 
A full migration from one IWSVA 6.5 SP2 device to another IWSVA 6.5 SP2 device 
is only supported if both devices are configured in standalone mode. 
 
To perform a full migration, make sure the hardware configuration and deployment 
mode are the same on both IWSVA machines. Trend Micro also recommends you 
configure both machines to use the same IP address to prevent unexpected behavior 
after a full migration.  
 
If the IP address information in the backup file is different from the IP address of the 
IWSVA machine to which you want to import the file, the migration results screen 
will not display. In this case, you can view the migration results in the Audit Log 
screen.  
 
After a full migration, if the separate management interface is enabled on the source 
IWSVA machine, you must use the management IP address of the source IWSVA 
machine to access the Web console on the target IWSVA 6.5 SP2 machine.

Procedure:

1. Open the Web console of the source IWSVA 6.5 SP2 machine and select 
Administration > Config Backup/Restore. Then, click Export to back up the 
configuration. 

The screen displays a progress bar. When the export process is finished, a result 
page displays the status. If the configuration export process is successful, IWSVA 
opens a dialog box to prompt you to save the configuration file to a local disk. Save 
the file to a local drive on your computer.

2. Open the Web console of the target IWSVA 6.5 SP2 machine and then click 
Administration > Config Backup/Restore from the main menu.

3. Click Browse to select a backup file and then click Import. 
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Note: If you are migrating from a source IWSVA 6.5 SP2 to a target IWSVA 6.5 SP2, 
and both devices are configured in standalone mode, you can choose to perform 
a full or partial migration. Otherwise, by default, only a partial migration is 
performed.

4. Choose an option and click OK to continue. 

After Migrating
Existing customers can check the “What’s New” section in the first chapter of the 
IWSVA Administrator’s Guide to see the new features that are available in this release. 
New customers can see all of the other IWSVA features listed after the “What’s New” 
section.
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Appendix A 

Deployment Integration

This appendix describes the following: 

• IWSVA in a Distributed Environment on page A-2

• Integration with LDAP on page A-4

• Integration with a Cisco Router using WCCP on page A-7

• Protecting an HTTP or FTP Server using Reverse Proxy on page A-8

• Integration with an ICAP Device on page A-9
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IWSVA in a Distributed Environment
InterScan Web Security Virtual Appliance (IWSVA) is designed to be part of a 
distributed system and can establish a number of network connections based on the 
configuration settings.

The administrator must ensure the following:

• None of the required channels are blocked

• All channels have enough throughput

• Servers use a supported version of the software

• Servers are able to handle heavy traffic load

Connection Requirements and Properties
Table A-1 provides the required connections and their properties.

TABLE A-1.   Required Connections and Properties 

CONNECTING 
COMPONENT

TRAFFIC: TYPE AND 
VOLUME

IF THE CONNECTION IS 
LOST

Clients Should be measured on the 
real network.

No protection

LDAP server (if 
configured)

Type: LDAP

Volume: Medium

Cached data is used for 
already started services.

Services will not start.

Trend Micro Active 
Update Server

Type: HTTP and HTTPS  

Volume: 10-50 Mb/day

IWSVA components can-
not be updated in time.
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Throughput and Availability Requirements
The administrator must determine the IWSVA availability requirements. 

• Is IWSVA downtime acceptable?

• If so, what is the proper action (bypass or stop) to enforce when IWSVA is down?

• If a failover configuration with multiple IWSVA instances is used, do the LDAP and 
database servers have the same level of failover?

Web Reputation Type: HTTP

Volume: Depends on the 
specific access

Cached data is used for 
already started services.

Service will not start and 
user is given access to 
requested URL.

TABLE A-1.   Required Connections and Properties (Continued)

CONNECTING 
COMPONENT

TRAFFIC: TYPE AND 
VOLUME

IF THE CONNECTION IS 
LOST
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Integration with LDAP

Support Multiple Domains for Multiple LDAP Servers
IWSVA has an LDAP module that allows communication with multiple LDAP servers 
with the ability to establish multidomain trees and forest-like environments.

IWSVA LDAP integration supports multiple domains and multiple LDAP servers. 

To configure the LDAP function at the IWSVA Web console:

1. Go to Administration > IWSVA Configuration > User Identification > User 
Identification 

2. Input the necessary information for the LDAP connection

3. Click Test Connection to verify the LDAP configuration and connectivity. A 
success message will appear if the test is successful. 

4. Click the Save to save the configuration.

Note: Before configuring LDAP, make sure the LDAP domain name is resolvable by the 
IWSVA DNS.

Two authentication methods are provided for user authentication. Standard 
authentication will provide a standard 401 or 407 authentication dialog box to specify 
the user account and password. If the client machine is a Windows desktop in the 
Microsoft Active Directory domain, transparent authentication will applied. Captive 
Portal will show a Web-based authentication page for user identification. Guest policy is 
applicable with Captive Portal authentication. Cookie mode is added in IWSVA 6.5 SP2 
to address user identification in NAT and terminal server environment which is only 
available in Captive Portal.

The Windows Active Directory (AD) Global Catalog enables LDAP clients, such as 
IWSVA, to query objects native to the domain being queried, and those residing in 
remote domains, as long as the AD server being queried and the remote AD server has 
Global Catalog enabled. The Global Catalog server accepts the LDAP requests on port 
3268 and allows querying the user credentials, full name and membership in the global 
and universal groups across all other domains in the forest. The use of the Global 
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Catalog is handy when creating IWSVA LDAP policies for a parent group with 
user(s)/group(s) member(s) residing on remote domains that are part of many 
subdomain levels.

To use this feature, the IWSVA administrator should configure the main LDAP server 
that IWSVA uses from the Web console Administrator > Configuration > User 
Identification page to communicate with a designated Global Catalog-enabled Active 
Directory server using port 3268, instead of using the default LDAP communication 
port 389.

Note: Global Catalog is only available in Microsoft Active Directory. The advantage of using 
the Global Catalog port includes better performance for LDAP object lookup, and 
allows object lookup that resides in many sublevels of the Active Directory tree 
(beyond three). However, in order for IWSVA to utilize the Global Catalog, the AD 
being requested for an object needs to have the Global Catalog enabled along with the 
AD where the queried user or group objects reside. IWSVA supports the use of the 
Global Catalog port only to be configured as the main LDAP server, and not part of 
the IWSVA referral chasing servers.

Tip:  Trend Micro recommends allowing IWSVA to query the root Active Directory server 
with the Global Catalog enabled, and using Universal group types to do group nesting 
when applying policies. This can be seen by the Global Catalog and will be visible 
throughout the Active Directory. For more information, see Microsoft support 
(http://support.microsoft.com/kb/231273).
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LDAP Authentication in Transparent Mode
Before configuring LDAP authentication on IWSVA deployed in transparent mode 
(bridge and WCCP), review the following criteria to ensure each item is fully met.

• IWSVA must have a valid hostname assigned at Administration > Network 
Configuration > Network Interface page in the Web console. Make sure the 
hostname is also entered in the corporate DNS server.

• Ensure that the user ID cache is enabled. By default, this is enabled. If it has been 
disabled for any reason, it must re-enabled before enabling transparent mode 
authentication. You can enable user ID cache using the configure module 
ldap ipuser_cache enable command in the CLI.

• By default, IWSVA keeps user ID cache information for up to two hours. If you 
need to lower the cache timeout value, use the configure module ldap 
ipuser_cache interval command in the CLI to set a shorter cache interval.

• If authentication is enabled, IWSVA will block all nonbrowser applications trying to 
access the Internet. For example, the MSN application might try to access the 
Internet before the user has a chance to log in to the IWSVA server. If this happens, 
the application will be blocked as the user has not successfully authenticated to 
IWSVA. You can perform one of the following:

a. Bypass LDAP authentication for the application by adding the URLs that 
application accesses to “Global Trusted URLs.” The URLs in this list will 
bypass both authentication and content scanning.

b. Instruct users to open their Web browsers and get authenticated before 
starting up applications that need Internet access.

c. Add the IP address of the client machine to “LDAP authentication White 
List.” IP address in this list will bypass LDAP authentication.

• When user or group authentication is enabled in either the forward proxy mode or 
the transparent mode with the Active Directory, you can take advantage of the 
automatic authentication feature provided in the Internet Explorer Web browser. 
With automatic authentication, clients already logged on to the domain network can 
access the local intranet without having to enter the log on information (such as the 
username and password); that is, no password pop-up screen displays. 
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Note: You must configure your IE settings to enable automatic authentication on each client 
computer.  
 
By default, automatic authentication is enabled in IE 7.0, IE 8, and IE 9. 

Refer to the Administrator’s Guide for additional information. 

Integration with a Cisco Router using WCCP
You can integrate IWSVA on a network that uses a Cisco router at the gateway without 
changing the browser settings of the client machines. This is achieved by utilizing Cisco’s 
WCCP protocol.

Note: For more information on deploying in WCCP mode, see the IWSVA 6.5 SP2 
Administrator's Guide, “Appendix F, WCCP Deployment & Troubleshooting.”
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Protecting an HTTP or FTP Server using 
Reverse Proxy

If you are protecting the HTTP server, install the HTTP scanning service in the HTTP proxy 
mode and use the reverse proxy configuration.

Note: To simplify the deployment of the reverse-proxy configuration in an 
HTTP/HTTPS environment, IWSVA can listen for incoming (HTTPS) 
connections on a port (default value is 443) configured in Deployment Wizard, 
decrypt and scan data, and forward the data to port 80 on the protected server 
using HTTP protocol. 

FIGURE A-1.   Protecting a Dedicated Server

If you are protecting the FTP server, install the FTP scanning service and configure it to use 
an FTP proxy.

• Define the following configuration settings in the [ftp] section of the pni-file: 

• proxy_mode=dedicated specifies operational mode
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Integration with an ICAP Device
You can integrate IWSVA on a network that utilizes an ICAP 1.0 compliant cache 
server.

Setting up an ICAP 1.0-compliant Cache Server
Configure an ICAP client to communicate with the ICAP server. 

• To set up ICAP for NetCache Appliance: on page A-9

• To set up ICAP for the Blue Coat Port 80 Security Appliance: on page A-11

• To set up ICAP for Cisco CE ICAP servers: on page A-14

Setting up ICAP for NetCache Appliances
To set up ICAP for NetCache Appliance:

1. Log on to the NetCache console by opening http://{SERVER-IP}:3132 in a 
browser window.

2. Click Setup, and then click ICAP > ICAP 1.0 in the left menu.

3. Click General, and then select Enable ICAP Version 1.0. Click Commit 
Changes. 

Note: An “icap: This service is not licensed” error message appears 
when you have not provided the required ICAP license key for NetCache.

4. Enter an ICAP license key:

a. Click the Setup tab, and then click System > Licenses on the left menu. The 
System Licenses screen appears.

b. Type IWFLPWA under the ICAP license section.

• ftp_server specifies the IP address of the protected FTP 
server

• ftp_server_port specifies the TCP port of the protected server
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c. Click Commit Changes.

5. Select the Service Farms tab on the ICAP 1.0 screen, and then click New Service 
Farm to add ICAP servers. Then, assign the service farm name in the Service 
Farm Name field.

• For response mode, select RESPMOD_PRECACHE in the Vectoring Point 
field

• For request mode, select REQMOD_PRECACHE in the Vectoring Point 
field

6. Select Service Farm Enable. 

7. In the Load Balancing field, choose the proper algorithm that you use for load 
balancing (if you have more than one ICAP server in the service farm). Clear 
Bypass on Failure. 

Note: Disable Bypass on Failure if the priority is more on virus propagation within 
your network. Otherwise, enable Bypass on Failure to guarantee an unblocked 
connection to the Internet.

8. Under the Consistency field, choose strong from the drop-down menu and leave 
the lbw Threshold field empty.

9. Under the Services text box (for response mode), type: 
icap://{ICAP-SERVER-IP}:1344/resp on,  
where ICAP-SERVER-IP is the IP address of IWSVA ICAP for response mode.

Under the Services text box (for request mode), type 
icap://{ICAP-SERVER-IP}:1344/REQ-Service on,  
where ICAP-SERVER-IP is the IP address of IWSVA ICAP for request mode.

For multiple IWSVA ICAP server services, type the additional entries in step 9. For 
example:

For response mode,

• icap://{ICAP-SERVER1-IP}:1344/resp on

• icap://{ICAP-SERVER2-IP}:1344/resp on

Click Commit Changes.

For request mode,
• icap://{ICAP-SERVER1-IP}:1344/REQ-Service on

• icap://{ICAP-SERVER2-IP}:1344/REQ-Service on
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Click Commit Changes.

Note: For multiple ICAP servers within a service farm with strong consistency 
selected, make sure that all ICAP servers have identical intscan.ini and 
other configuration files and the same virus pattern. The service farm will not 
work properly if the ICAP servers have different configurations. 

10. Click the Access Control Lists tab, and then select Enable Access Control Lists. 

11. Type icap (Service Farm name of the ICAP Server) any in the 
HTTP ACL field.

12. Click Commit Changes.

To configure scanning FTP over HTTP traffic, go to FTP > Configuration > 
Access Control Lists, and then add “icap (service farm name)” into the 
FTP ACL field. 

Setting Up ICAP for the Blue Coat Port 80 Security 
Appliance

To set up ICAP for the Blue Coat Port 80 Security Appliance:

1. Log on to the management console by typing http://{SERVER-IP}:8081 in the 
address bar of your Web browser (specifying port 8081 as the default management 
port).

For example, if the IP address configured during the first-time installation is 
123.123.123.12, enter the URL http://123.123.123.12:8081 in the Web browser. 

2. Select Management. Type the log on username and password if prompted.

3. Click ICAP in the left menu, and then click ICAP Services. 

4. Click New. The Add ICAP Service screen appears. 

5. In the ICAP service name field, type an alphanumeric name and then click OK. 

6. Highlight the new ICAP service name and click Edit. 

The Edit ICAP Service name screen appears. 

7. Type or select the following information: 

a. ICAP version number (that is, 1.0)
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b. The service URL, which includes the virus-scanning server host name or IP 
address, and the ICAP port number. The default ICAP port number is 1344. 

• Response mode:
icap://{ICAP-SERVER-IP}:1344 

• Request mode:
icap://{ICAP-SERVER-IP}:1344/REQ-Service

where ICAP-SERVER-IP is the IP address of IWSVA ICAP.

c. The maximum number of connections (ranges from 1-65535). The default 
value is 5.

d. The connection timeout, which is the number of seconds the Blue Coat Port 
80 Security Appliance waits for replies from the virus-scanning server. The 
range is an interval from 60 to 65535. The default timeout is 70 seconds.

e. Choose the type of method supported (response or request modes).

f. Use the default preview size (bytes) of zero (0).

g. Click Sense settings to retrieve settings from the ICAP server 
(recommended).

h. To register the ICAP service for health checks, click Register under the 
Health Check Options section.

8. Click OK and then click Apply.

Note: You can edit the configured ICAP services. To edit a server configuration again, 
select the service and click Edit. The examples used for configuring ICAP for 
Blue Coat are based on version 2.1.07. The settings might vary depending on the 
version of Blue Coat used.

9. Add a response or request mode policy. 

The Visual Policy Manager requires the Java 2 Runtime Environment Standard 
Edition v.1.3.1 or later (also known as the Java Runtime or JRE) from Sun™ 
Microsystems, Inc. If you already installed JRE on your workstation, the Security 
Gateway opens a separate browser window and starts the Visual Policy Manager. 
The first time you start the policy editor, it displays an empty policy. 
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If you have not installed JRE on your workstation, a security-warning window 
appears. Click Yes to continue. Follow the instructions to install the JRE. 

To add the response mode policy: 

a. Select Management. Type the log on username and password if prompted.

b. Click Policy in the left menu, and then click Visual Policy Manager. 

c. Click Start. 

If the Java Plug-in Security Warning screen appears, click Grant this 
session.

d. On the menu bar, click Edit > Add Web Content Policy. 

The Add New Policy Table screen appears.

e. Type the policy name under the Select policy table name field. Click OK.

f. Under the Action column, right-click Bypass ICAP Response Service and 
click Set. 

The Add Object screen appears. 

g. Click New and select Use ICAP Response Service. 

The Add ICAP Service Action screen appears.

h. Choose the ICAP service name under the ICAP Service/Cluster Names 
field. Enable Deny the request under the On communication error with 
ICAP service section. Click OK, and then click OK again.

i. Click Install Policies.

To add the request mode policy: 

a. Select Management. Type the log on username and password if prompted.

b. Select Policy in the left menu, and then click the Visual Policy Manager tab. 

c. Click Start. If the Java Plug-in Security Warning screen appears, click Grant 
this session.

d. On the menu bar, click Edit > Add Web Access Policy. 

The Add New Policy Table screen appears.

e. Type the policy name under the Select policy table name field. Click OK.
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f. Under the Action column, right-click Deny and click Set. 

The Add Object screen appears. 

g. Click New and select Use ICAP Request Service. The Add ICAP Service 
Action screen appears.

h. Choose the ICAP service name under the ICAP Service/Cluster Names 
field. 

i. Enable Deny the request under the On communication error with ICAP 
service section. 

j. Click OK, and then click OK again.

k. Click Install Policies.

10. To check the current policy, go to the Policy screen, click the Policy Files tab, and 
then click Current Policy.

FIGURE A-2.   Current configured policy

Setting up ICAP for Cisco CE ICAP Servers
IWSVA supports Cisco ICAP servers (CE version 5.1.3, b15). All ICAP settings are 
performed through a command line interface (CLI); there is no user interface associated 
with the Cisco ICAP implementation.

To set up ICAP for Cisco CE ICAP servers:

1. Open the Cisco CE console.

2. Type config to enter the configuration mode.
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3. Type ICAP to display a list of all ICAP-related commands.

4. Create a response modification service, by typing the following:

icap service RESPMOD SERVICE NAME

The ICAP service configuration menu opens. Display a list of all available 
commands. Type the following commands:

server icap://ICAP SERVER IP:1344/resp (to assign a server type)

vector-point respmod-precache (to assign the proper vector point type)

error-handling return-error (to assign the proper error-handling type)

enable (to enable the ICAP multiple server configuration)

5. Type exit. 

6. Create a request modification service, by typing:

icap service REQUESTMOD SERVICE NAME

This command takes you into the ICAP service configuration menu. Display a list 
of all available commands. Issue the following commands:

server icap://ICAP SERVER IP:1344/REQ-Service (to assign a server 
type)

vector-point reqmod-precache (to assign the proper vector point type)

error-handling return-error (to assign the proper error-handling type)

enable (to enable the ICAP multiple server configuration)

7. Type exit.

8. For additional configuration steps, type the following:

icap append-x-headers x-client-ip (to enable X-client headers for reports)

icap append-x-headers x-server-ip (to enable X-server headers for reports)

icap rescan-cache ISTag-change (to turn on ISTAG rescan for updates)

icap bypass streaming-media (to exclude streaming media from ICAP 
scanning)

icap apply all (to apply all settings and activate ICAP type)

show icap (to display current ICAP configuration at root CLI menu)
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Configuring Virus-scanning Server Clusters
For the Blue Coat Port 80 Security Appliance to work with multiple virus-scanning 
servers, you must configure a cluster in the Security Gateway (add the cluster, and then 
add the relevant ICAP services to the cluster). 

To configure a cluster using the management console:

1. Select Management. 

Type the log on username and password if prompted.

2. Click ICAP in the left menu, and then click the ICAP Clusters tab. 

3. Click New. 

The Add ICAP Cluster screen appears. 

4. In the ICAP cluster name field, type an alphanumeric name and then click OK. 

5. Highlight the new ICAP cluster name and click Edit. 

The Edit ICAP Cluster name screen appears. 

6. Click New to add an ICAP service to the cluster. 

The Add ICAP Cluster Entry screen appears. The pick list contains a list of any 
services available to add to the cluster. 

7. Choose a service and then click OK. 

8. Highlight the ICAP cluster entry and click Edit. 

The Edit ICAP Cluster Entry name screen appears. 

9. In the ICAP cluster entry weight field, assign a weight from 0-255.

10. Click OK and then OK again, and finally Apply. 

Deleting a Cluster Configuration or Entry
You can delete the configuration for an entire virus-scanning server cluster, or you can 
delete individual entries from a cluster. 

Note: Do not delete a cluster used in a Blue Coat Port 80 Security Appliance policy if a 
policy rule uses a cluster name. 
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To delete a cluster configuration using the management console:

1. Select Management. Type the log on username and password if prompted.

2. Click ICAP in the left menu, and then click the ICAP Clusters tab. 

3. Click the cluster you want to delete. 

4. Click Delete, and then click OK to confirm.

Enabling “X-Virus-ID” and “X-Infection-Found” Headers
IWSVA can return two optional headers from the ICAP server whenever a virus is 
found: the “X-Virus-ID” and the “X-Infection-Found” headers. Neither of these 
headers are returned by default for performance reasons, because many ICAP clients do 
not use these headers. They must be enabled in the IWSVA management console.

• “X-Virus-ID” contains one line of US-ASCII text with a name of the virus or risk 
encountered. For example:

X-Virus-ID: EICAR Test String

• “X-Infection-Found” returns a numeric code for the type of infection, the 
resolution, and the risk description.

For more details on the parameter values, see:

http://www.icap-forum.org/documents/specification/draft-stecher
- 
icap-subid-00.txt

To enable the X-Virus-ID header:

1. From the main menu, click Administration > Network Configuration > 
Deployment Mode.

2. On the Deployment Mode page, select Enable 'X-Virus-ID' ICAP header 
and/or Enable 'X-Infection-Found' ICAP header.
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Appendix B 

Tuning and Troubleshooting

This appendix explains the following:

• IWSVA Performance Tuning on page B-2

• Troubleshooting on page B-6
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IWSVA Performance Tuning
If you are experiencing issues with slow browsing performance, consider the following 
modifications and the InterScan Web Security Virtual Appliance (IWSVA) remote rating 
service.

URL Filtering
IWSVA utilizes the Trend Micro URL Filtering Engine to perform URL categorization 
and reputation rating based on the data supplied by the Trend Micro Web Reputation 
feature. Trend Micro recommends using the default setting of a weekly update check to 
ensure that your installation has the most current URL Filtering Engine.

IWSVA can control URL access based on Web Reputation feedback, the URL Filtering 
module, or a combination of both. The combination of Web Reputation and the URL 
Filtering module is a multi-layered, multi-threat protection solution provided by IWSVA.

The URL Filtering module grants or denies Web access based on the category to which 
a URL belongs. Web Reputation grants or denies Web access based on whether the 
requested URL is a phishing or pharming threat, has hacking potential, or has a 
reputation score that deems it untrustworthy. Both the optional URL Filtering module 
and Web Reputation are controlled by the specifications you make in policies.

For additional details, see Chapter 8 in the Administrator’s Guide.

LDAP Performance Tuning
When running IWSVA to use the User/group name authentication identification 
method (LDAP), HTTP proxy performance becomes dependent upon the 
responsiveness of the LDAP directory server. In a worst case scenario, every HTTP 
request would require an LDAP query to authenticate the user's credentials. These 
queries introduce latency in terms of the transmit and receive delay between IWSVA and 
the LDAP server, and add load to the LDAP server itself.

LDAP Internal Caches
To reduce the amount of LDAP queries required, IWSVA provides several internal 
caches:
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• User group membership cache: This cache can store group membership 
information. By default, entries in this cache will be valid for two hours, or until the 
cache fills (at which point the entries are replaced, starting with the oldest).  
 
The time to live (TTL) for entries in this cache can be configured in the Web 
console: Administrator > IWSVA Configuration > User Identification.

• Client IP to User ID cache: This cache associates a client IP address with a user who 
recently authenticated from that same IP address. Any request originating from the 
same IP address as a previously authenticated request will be attributed to that user, 
provided the new request is issued within a configurable window of time (15 
minutes by default for HTTP, 90 minutes for ICAP) from that authentication. The 
caveat is that client IP addresses seen by IWSVA must be unique to a user within 
that time period, thus this cache is not useful in environments where there is a proxy 
server or source NAT between the clients and IWSVA, or where DHCP frequently 
reassigns client IPs.  
 
To enable or disable this cache, change the enable_ip_user_cache setting in 
the [user-identification] section of the intscan.ini file. To change the TTL of 
this cache, change the ip_user_central_cache_interval (unit is hours). For 
example, to create a TTL of 30 minutes, enter 0.5.

• User authentication cache: This avoids re-authenticating multiple HTTP requests 
passed over a persistent connection. When users pass the credential validation over 
a persistent connection, IWSVA adds an entry (two important keys in one cache 
entry are the client’s IP address and the client’s username) in the user authentication 
cache so the subsequent requests over a keep-alive connection will not authenticate 
again. The client IP address and client’s username serve as two forward references, 
or links, to the “client IP to user ID cache” and “user group membership cache,” 
respectively. IWSVA will thus still be able to retrieve the user’s connection 
information from both the IP-user and user-group caches.

When deploying IWSVA with LDAP integration, it is important to consider the 
additional load that authenticating HTTP requests will place on the LDAP directory 
server. In an environment that cannot effectively use the client IP to user ID cache, the 
directory server will need to be able to handle queries at the same rate as IWSVA 
receives HTTP requests.
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Disable Verbose Logging When LDAP is Enabled
Trend Micro recommends turning off verbose logging in the intscan.ini file, under 
the [http] section, “verbose” parameter) when LDAP is enabled for server performance 
reasons. Verbose logging is primarily used by software developers to identify abnormal 
application behavior and troubleshooting. In a production deployment, verbose logging 
is usually unnecessary.

If verbose logging is enabled and LDAP is also enabled, IWSVA will log user 
authentication information and group membership information in the HTTP log in the 
\Log folder. Logs might contain hundreds of lines per user and, therefore, significantly 
consume disk space, depending on the amount of internal traffic and the number of 
groups with which a user is associated. Verbose logging keeps the service busy with 
issuing I/O operations to the operating system. This might prevent the service from 
responding to HTTP requests in a timely fashion, and latency might occur. In an 
extreme bursting HTTP traffic environment, it’s possible to observe significant delays 
when IWSVA starts up in the verbose mode.

LDAP Authentication in Transparent Mode
Before configuring LDAP authentication on IWSVA deployed in transparent mode, 
review the following criteria to ensure each item is fully met.

• IWSVA must have a valid hostname assigned (click Administration > 
Deployment Wizard, then update host name on Network Interface page). Make 
sure the hostname is also entered in the corporate DNS server.

• Ensure that the user ID cache is enabled. By default, this is enabled. If it has been 
disabled for any reason, it must re-enabled before enabling transparent mode 
authentication. You can enable user ID cache using the configure module 
ldap ipuser_cache enable command in the CLI.

• By default, IWSVA keeps user ID cache information for up to two hours. If you 
need to lower the cache time-out value, use the configure module ldap 
ipuser_cache interval command in the CLI to set a shorter cache interval.

• If authentication is enabled, IWSVA will block all nonbrowser applications trying to 
access the Internet. For example, the MSN application might try to access the 
Internet before the user has had a chance to log in the IWSVA server. If this 
happens, the application will be blocked as the user has not successfully 
authenticated to IWSVA. You can perform one of the following:
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a. Bypass LDAP authentication for the application by adding the URLs that 
application accesses to “Global Trusted URLs.” The URLs in this list will 
bypass both authentication and content scanning.

b. Instruct users to open their Web browsers and get authenticated before 
starting up applications that need Internet access.

c. Add the IP address of the client machine to “LDAP authentication White 
List.” IP address in this list will bypass LDAP authentication.

Note: When User/group authentication is enabled in either forward proxy mode or 
transparent mode with an Active Directory, you can take advantage of the automatic 
authentication feature provided in the Internet Explorer Web browser. With automatic 
authentication, clients already logged on to the domain network can access the local 
intranet without having to enter the log on information (such as the username and 
password); that is, no password pop-up screen displays. 
 
Refer to the IWSVA Administrator’s Guide for detailed configuration steps.
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Troubleshooting

Troubleshooting Tips
• Issue: IWSVA could not connect to the database specified in the Database 

Connection Settings page. The IWSVA management console displays the following 
error message:

JDBC-ODBC BRIDGE: [UNIXODBC] Could not connect to the 
server; Could not connect to remote socket.

Solution: 

• Check the ODBC connection or the database server and try again.

• Issue: The IWSVA management console displays an authentication error message.

JDBC-ODBC BRIDGE: [UNIXODBC]FATAL: Password authentication 
failed for user.

Solution: 

• Verify the user credential for the PostgreSQL Server and also ensure that the 
database settings are correct (Administration > IWSVA Configuration > 
Database Connections). If the problem persists, ensure that the permissions 
in the etc/iscan/odbc.ini file are correct.

Before Contacting Technical Support
When contacting Technical Support with your issues, having specific information can 
streamline the process.

Installation Problems
Collect the following information about your installation problem before contacting 
Trend Micro technical support to expedite the process.

1. IWSVA version and build number

2. Screenshot of the exact error that appears during installation

3. The stage of the installation 
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General Feature Problems
If you have problems with IWSVA, collect the following information to provide to 
Trend Micro support:

• The system file(s) that describes the current state of IWSVA.

To compile these files, access the Web console and choose Administration > 
Support and then click Generate System Information File. This button is an 
extension of the Case Diagnostic Tool (CDT), allowing you to package the current 
machine “state” at a click of a button. 

The system file(s) that IWSVA generates from clicking the Generate System 
Information File button are packaged into a single file with the following format:
info_YYYYMMDD_999999.tar.tz

Where YYYY is the current year, MM is the current month, and DD is the current day 
that the package file was generated. 999999 is the UNIX time code.

The system file(s) contains the following information:

• IWSVA information—Includes IWSVA product version, engine version and 
build number, current pattern file (if available), and IWSVA hot fixes and 
service pack information. Product and integration settings are also part of this 
information

• IWSVA system logs—Includes IWSVA logs and debug logs, logs generated by 
the syslogd daemon (if system logs are enabled), and the core dump file 

• System/network information—Includes the hardware configuration, 
operating system, build, system resource status, other application installed, and 
network information

• CDT-compliant configuration/plug-ins information—Includes 
information about changes made to CDT as a result of IWSVA adding a new 
component, such as a TMCM or MCP agent

• Core files are first created in the first directory listed below, and then moved to the 
second directory listed:
• /etc/iscan/CoreDump

• /etc/iscan/UserDumps
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Use these files when working with Trend Micro technical support to help diagnose 
the cause of your problem. To view the files yourself, use a program like GDB, the 
GNU Project debugger.

• Log file for the day the issue occurred

• All log files the day the issue occurred (logs are stored in /etc/iscan/log by 
default)

• Make sure verbose=1 is set in the [ftp], [http], and [notification] sections of 
the intscan.ini file

• Make sure log_trans=yes is set under the [ftp] and [http] sections of the 
intscan.ini file

• From the Web console, take a screen shot of the System Status page.

• Record the IWSVA version number

• URL samples (if applicable)

• Get a packet capture of the failing transaction by using the CLI capture command 
(for example, enter start task capture interface eth0 in enable mode). 
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Appendix C c 

Best Practices for IWSVA Installation 
and Deployment

This appendix describes the following:

• IWSVA Installation Overview on page C-2

• Properly Sizing Your Environment on page C-4

• Selecting Deployment Method and Redundancy on page C-5
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IWSVA Installation Overview
This installation overview provides a quick reference on the order and key steps to 
install and configure InterScan Web Security Virtual Appliance (IWSVA) to function 
with the core scanning, logging, and reporting features. The detailed sections in the Best 
Practices appendix of the IWSVA Administrator’s Guide will provide the URLs for 
downloading the necessary material. For complete instructions on installing IWSVA, 
please refer to the following chapters:

• Installing InterScan Web Security Virtual Appliance on page 3-1

• Migrating to InterScan Web Security Virtual Appliance on page 4-1

For complete feature and command instructions, refer to the IWSVA Administrator 
Guide.

To install and configure IWSVA:

1. Obtain the latest IWSVA software and documentation set from the Trend Micro 
Update Center or by purchasing the IWSVA installation disks. You can download 
IWSVA products and updates from:

http://downloadcenter.trendmicro.com/index.php?regs=NABU&clk=result_pag
e&clkval=drop_list&prodid=86

2. Register the product to obtain the Activation Codes. These will be required to 
activate IWSVA and its core modules. Products can be registered at:

https://olr.trendmicro.com/registration/us/en-us/product_login.aspx

3. Review the IWSVA Customer Sizing Guide and IWSVA Installation Guide to determine 
the deployment topology and the number of IWSVA units required to support your 
environment.

4. Install the IWSVA application with the Activation Keys obtained from Step 2. Use 
the Administration > Product License function to perform this task.

5. Download any service packs and critical patches that are applicable to the IWSVA 
product you installed. Service packs and critical patches are version specific and are 
cumulative with the latest service pack containing the previous hot fixes and critical 
patches from the previous service packs. Best practice is to download and install the 
latest service pack for your IWSVA version and any newer critical patches to bring 
the IWSVA unit up to date.
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IWSVA provides operating system updates separately from application service 
packs. Make sure the latest operating system patch is also downloaded and applied 
along with the application service pack. Always read the patch's ReadMe file to 
familiarize yourself with the installation procedure before upgrading your system.

Use the Administration > System Updates functions to perform these tasks.

6. Configure the system settings. This includes setting the system date and time, 
configuring optional network configurations (such as enabling SSH for remote 
access, PING, optional static routes, etc), defining optional upstream proxy servers, 
enabling SNMP, and so forth. Use the Administration function to perform these 
tasks.

7. Configure IWSVA to a corporate LDAP server if you need to enforce policies, log 
events, and report Internet activity based on LDAP users and/or groups. Use the 
Administration > IWSVA Configuration > User Identification tab to perform 
this function.

8. Review the default settings for the automatic pattern file and scan engine update 
intervals. Change to meet your needs if necessary. You can also perform a manual 
update for a newly installed IWSVA system to update the signature files and scan 
engines. Use the Updates function to perform these tasks.

9. Configure log settings and external syslog servers to set the logging granularity and 
setup any 3rd party logging support. Review the default system log retention option 
and change to meet your needs if necessary. Use the Logs function to perform these 
tasks.

10. Create policies to monitor and govern Internet traffic. Policies can be defined for 
the following protocols and traffic types: Application Control, Bandwidth Control, 
HTTPS, HTTP, Applet & ActiveX, URL Filtering, Access Quota, and FTP. Use the 
Application Control, Bandwidth Control, HTTP and FTP functions to perform 
these tasks.

11. Define report templates and scheduled reports. Review the default number of 
scheduled reports to save for your daily, weekly, and monthly reports. If necessary, 
change to meet your needs. Use the Reports function to complete these tasks.

12. Create additional administrator, auditor, or reporter accounts to backup your 
administrator account and to grant other users access to administrative and 
reporting functions. Use the Administration > Management Console > 
Account Administration function to complete this task.
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13. Backup the IWSVA configuration to keep a copy of the newly created 
configuration. Use the Administration > Config Backup/Restore function to 
complete this task.

14. Optional installation steps may include the following:

• Customizing the notification messages

• Registering IWSVA to the Advanced Reporting & Management (ARM) module

• Registering IWSVA to Trend Micro's Control Manager (TMCM) central 
management system

Properly Sizing Your Environment
Before installing IWSVA into your network, you must first determine how many IWSVA 
servers are required to support your company's user population and Internet activity. 
Please refer to the IWSVA Customer Sizing Guide for detailed information on how to 
calculate the number of IWSVA units needed for your environment. 

Things to consider for properly sizing your environment include:

• Number of total users in your company that will access the Internet

• Number of users accessing the Internet simultaneously

• Average number of concurrent sessions used by each active user

• Growth in user population and Internet use

• The type of server hardware being used

• The amount of bandwidth IWSVA needs to scan

• Redundancy and failover

Best Practice Suggestions
• Always size your environment for growth. Trend Micro doesn't recommend sizing 

your deployment based on current maximum peak loads as internet usage will 
always grow. 

• Architect redundancy into the IWSVA architecture to prevent against single points 
of failure and to provide roll over during a device failure. 
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• Redundant architectures must be designed to support your maximum number of 
users when it fails over to the backup unit or secondary. Otherwise, performance 
and response time expectations will drop when a unit fails.

Selecting Deployment Method and Redundancy
IWSVA is one of the most flexible Web gateway security products for deployment 
options. IWSVA can be deployed in the following topologies:

• Forward Proxy

• Transparent Bridge

• Transparent Bridge for High Availability

• WCCP

• ICAP

• Reverse Proxy

• Simple Transparency

Each deployment mode has its benefits and services a specific need. You should be 
aware of the advantages and disadvantages of each deployment mode before deciding on 
how to install the IWSVA product into your network. Please see Deployment Primer on page 
2-1 for detailed information on each deployment method and what key benefits are 
offered by each one.

If you are considering redundant architectures, you must review and consider the 
following points:

WCCP - IWSVA supports the Cisco WCCP protocol to allow you to build load sharing, 
redundancy, and scalability into your IWSVA architecture. If your routers and/or 
switches support Cisco WCCP, this is one of the most economical ways to add high 
availability features. One drawback of WCCP is that it can only redirect popular Internet 
protocols to the scanning devices efficiently. See the IWSVA ReadMe document for the 
WCCP versions supported.

ICAP - IWSVA supports ICAP v1.0 devices to allow you to scan content from popular 
caching servers. ICAP can also be used to create a scalable architecture through a 
one-to-many configuration with several IWSVA servers connected to a single cache 
server. This is a popular option for customers who need to cache web content to reduce 
bandwidth consumption and to lower Internet latency.
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Apache Traffic Server (ATS) - IWSVA bundles the popular open source caching 
program, called Apache Traffic Server (ATS), to offer customers an economical way to 
cache web content without paying additional licensing fees. Starting with IWSVA 6.5 
SP2, basic ATS configuration and enablement is integrated with the IWSVA 6.5 SP2 
Web console. ATS is supported in upstream proxy mode with IWSVA 6.5 SP2. ATS 
support is offered through the open source community and is provided by Trend Micro 
on its Web Gateway products for convenience.

Proxy Pac File - Simple load sharing can be created through a proxy pac file if you are 
deploying in Forward Proxy mode. Many customers have experienced good results by 
creating a proxy pac file that routes traffic to a specific IWSVA device based on source 
IP address or source network. This allows you to manually scale your network and to 
load share users across many IWSVA servers without any added costs or network 
complexity. 

You can also configure the proxy pac file to return multiple proxy servers to build a 
simple redundancy solution. Be aware that not all browsers may be able to interpret the 
multiple proxy server response. If they can't interpret the multiple proxy servers, 
redundancy will not be possible.

Layer 4 Load Balancing Switches - IWSVA can support external load balancing 
switches in Forward Proxy Mode using the “simple transparency” feature. Having an 
external load balancing switch adds additional cost and configuration complexity, but 
delivers the highest performance and flexibility in terms of redundancy and load sharing. 
Commercial load balancers that Trend Micro customers have used successfully include 
Foundry Networks/Brocade, F5, and Citrix NetScaler. If cost is a consideration, 
alternative open source software-based load balancers such as Red Hat Enterprise can 
also provide good scalability and redundancy options.

• If installing under VMware, consider using VMware's redundancy and fault tolerant 
functions to create a robust and scalable solution. These include:

• VMotion

• vSphere Fault Tolerance Services

Be aware that at the time of this writing, vSphere's Fault Tolerance service only permits 
one virtual CPU. This allows a full redundant solution to be developed, but offers less 
performance due to the single CPU limitation. For more information on setting up a 
vSphere FT configuration, refer to the Best Practices Guide for Utilizing VMware Fault 
Tolerance for High Availability document on the VMware web site.
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Best Practice Suggestions
• IWSVA uses a hybrid malware scanning architecture that is comprised of 

cloud-based scanning and on-box scan engines. This solution provides one of the 
industry's highest detection and prevention rates. Cloud-based scan engines provide 
proactive detection and blocking services based on reputation services. To ensure 
fast performance with low latency, you need to provide IWSVA access to a fast and 
robust DNS architecture. ISP provided DNS servers should not be used as frequent 
DNS requests made by the IWSVA device may not be adequately supported and 
may possibly overwhelm the ISP's DNS server.

• IWSVA's internal clock settings should be synchronized with other servers and 
devices in your security architecture. These include LDAP servers, syslog servers, 
upstream SIEM devices, and Trend Micro's Advanced Reporting and Management 
server. If the date and time are mismatched, you may experience improper logging 
and reporting of critical events. For best results, use the same set of NTP servers to 
sync the date and time on all devices.

• For high volume installations of more than 3000 users, you should consider 
dedicating a server to house the Apache Traffic Server (ATS) caching function (if 
enabled). During high workloads, IWSVA and ATS will contend for the same disk 
services. This will affect the cache hit performance as well as the performance of the 
IWSVA. One alternative is to use ram for caching tasks for ATS in IWSVA.

• For redundancy and scalability, consider installing more than one instance of 
IWSVA and using one of the scaling options mentioned in this section to eliminate 
single points of failure and improve system up time. Alternatively, two IWSVA 
devices can be installed as cluster pairs in High Availability deployment mode.

• For installations with an upstream proxy, you must properly configure IWSVA’s 
upstream proxy settings in the Forward Proxy settings and the Update Connection 
Settings to ensure proper Internet access.

• If you are planning to use IWSVA to protect external facing web servers that 
customers can access, consider installing a separate instance of IWSVA in reverse 
proxy mode to protect these web servers. Do not place the external facing web 
servers behind your corporate IWSVA server that your normal users would go 
through as this may affect your ability to enforce both customer facing policies and 
your normal corporate user policies.
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• For installations with Transparent Bridge mode on VMWare ESX, the external 
interface of IWSVA will connect to a virtual switch which binds to a physical 
network adapter. It is better not to connect any other virtual machine to this virtual 
switch and leave the virtual machine dedicate for IWSVA usage.

• After installing IWSVA, always check the Trend Micro download site for additional 
critical patches and/or service packs to ensure that the latest patches are installed. 
Patches listed on the IWSVA Download site are listed in chronological order. 
Always apply the latest application and OS patches to your specific version. IWSVA 
service packs are backwardly compatible. That is, the latest service pack will always 
contain any hot fixes and patches issued prior to the service pack's release date. You 
do not need to install previous patches before the latest applicable service pack for 
your product. IWSVA may have the following patch types:

• Application Service Pack - a service pack or patch that is used to update the 
IWSVA application. The latest service pack will contain all previously released 
patches.

• OS Service Pack - a service pack or patch that is used to update the operating 
system and driver files. The latest service pack will contain all previously 
released patches.

• Critical Patch - a patch that is used to fix an urgent application or OS problem 
and will not contain previous patches. It is only issued to fix a specific problem.
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Maintenance and Technical Support

This appendix describes the following:

• Product Maintenance on page D-2

• Contacting Technical Support on page D-4

• Security Information Center on page D-7
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Product Maintenance
From time to time, Trend Micro might release a patch for a reported known issue or an 
upgrade that applies to your product. To find out whether there are any patches available 
for InterScan Web Security Virtual Appliance (IWSVA), visit the following URL:

http://www.trendmicro.com/download/

The Update Center screen displays. Select your product from the links on this screen:

Clicking the link for Trend Micro™ InterScan™ Web Security Virtual Appliance 
(IWSVA) takes you to the Update Center page for IWSVA. Scroll down to review the 
patches that are available. 

Patches are dated. If you find a patch that you have not applied, open the readme 
document to determine whether the patch applies to you. If so, follow the installation 
instructions in the readme.

Maintenance Agreement
A Maintenance Agreement is a contract between your organization and Trend Micro, 
regarding your right to receive technical support and product updates in consideration 
for the payment of applicable fees. When you purchase a Trend Micro product, the 
License Agreement you receive with the product describes the terms of the Maintenance 
Agreement for that product.

A license to the Trend Micro software usually includes the right to product updates, 
pattern file updates, and basic technical support (“Maintenance”) for one (1) year from 
the date of purchase only. After the first year, Maintenance must be renewed on an 
annual basis at Trend Micro’s then-current Maintenance fees. 

Note: If the Maintenance Agreement expires, your License Agreement will not.

If the Maintenance Agreement expires, scanning can still occur, but the product cannot 
be updated, even manually. Also, you will not be entitled to receive technical support 
from Trend Micro. 
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Typically, ninety (90) days before the Maintenance Agreement expires, you will be 
alerted of the pending discontinuance. You can update your Maintenance Agreement by 
purchasing renewal maintenance from your reseller, Trend Micro sales, or on the Trend 
Micro Online Registration URL: 

https://olr.trendmicro.com/registration/ 

Renewing Your Maintenance Agreement
Trend Micro or an authorized reseller provides technical support, pattern file 
downloads, and program updates for one (1) year to all registered users, after which you 
must purchase renewal maintenance.

If your Maintenance Agreement expires, scanning will still be possible, but pattern file 
and program updates will stop. To prevent this, renew the Maintenance Agreement as 
soon as possible. 

To purchase renewal maintenance, contact the same vendor from whom you purchased 
the product. A Maintenance Agreement, extending your protection for a year, will be 
sent by post to the primary company contact listed in your company’s Registration 
Profile. 

To view or modify your company’s Registration Profile, log on to the account at the 
Trend Micro online registration Web site:

https://olr.trendmicro.com/registration 

You are prompted to enter a log on ID and password. 

To view your Registration Profile, type the log on ID and password created when you 
first registered your product with Trend Micro (as a new customer), and then click Log 
on.
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Contacting Technical Support
To contact Trend Micro Technical Support, visit the following URL:

http://www.trendmicro.com/us/home/products/support-services/ind
ex.html

Then, click the link for one of the following regions:

• Asia/Pacific

• Australia and New Zealand

• Europe

• Latin America

• United States and Canada

Follow the instructions for contacting support in your region.

In the United States, Trend Micro representatives can be reached through phone, fax, or 
email. Our Web site and email addresses follow:

http://www.trendmicro.com

support@trendmicro.com

For regional contact information and the specific technical support numbers for all the 
regional and worldwide offices, open the IWSVA management console and choosing 
Support from the menu in the management console’s banner. 

General US phone and fax numbers follow: 

Voice: +1 (408) 257-1500 (main)

Fax: +1 (408) 257-2003

Our US headquarters is located in the heart of Silicon Valley:

Trend Micro, Inc. 
10101 N. De Anza Blvd. 
Cupertino, CA 95014
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TrendLabs
TrendLabs is Trend Micro’s global infrastructure of antivirus research and product 
support centers that provide up-to-the minute security information to Trend Micro 
customers.

The “virus doctors” at TrendLabs monitors potential security risks around the world, to 
ensure that Trend Micro products remain secure against emerging risks. The daily 
culmination of these efforts are shared with customers through frequent virus pattern 
file updates and Advanced Threat Scan Engine refinements.

TrendLabs is staffed by a team of several hundred engineers and certified support 
personnel that provide a wide range of product and technical support services. 
Dedicated service centers and rapid-response teams are located in Tokyo, Manila, Taipei, 
Munich, Paris, and Lake Forest, CA, to mitigate virus outbreaks and provide urgent 
support.

Knowledge Base
The Trend Micro Knowledge Base is a 24x7 online resource that contains thousands of 
do-it-yourself technical support procedures for Trend Micro products. Use Knowledge 
Base, for example, if you are getting an error message and want to find out what to do 
to. New solutions are added daily. 

Also available in Knowledge Base are product FAQs, hot tips, preventive antivirus 
advice, and regional contact information for support and sales. 

Knowledge Base can be accessed by all Trend Micro customers as well as anyone using 
an evaluation version of a product. Visit: 

http://esupport.trendmicro.com/en-us/business/pages/technical-s
upport.aspx

And, if you can't find an answer to a particular question, the Knowledge Base includes 
an additional service that allows you to submit your question through an email message. 
Response time is typically 24 hours or less. 
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Known Issues
Known issues are features in your IWSVA software that might temporarily require a 
workaround. Known issues are typically documented in section 7 of the Readme 
document you received with your product. Readme files for Trend Micro products, 
along with the latest copies of the product manuals, can also be found in the Trend 
Micro Update Center:

http://www.trendmicro.com/download/

Known issues can be found in the technical support Knowledge Base: 

http://esupport.trendmicro.com/en-us/business/pages/technical-s
upport.aspx

Trend Micro recommends that you always check the Readme file for information on 
known issues that could affect installation or performance, as well as a description of 
what’s new in a particular release, system requirements, and other tips. 

Sending Suspicious Code to Trend Micro
You can send your viruses, infected files, Trojans, suspected worms, spyware, and other 
suspicious files to Trend Micro for evaluation. To do so, visit the Trend Micro 
Submission Wizard URL:

http://subwiz.trendmicro.com/SubWiz 

Click the “Submit a suspicious file/undetected virus” link. The following screen 
displays.

You are prompted to supply the following information:

• Email: Your email address where you would like to receive a response from the 
antivirus team.

• Product: The product you are currently using. If you are using multiple Trend 
Micro products, select the product that has the most effect on the problem 
submitted, or the product that is most commonly in use.

• Number of Infected Seats: The number of users in your organization that are 
infected.

• Upload File: Trend Micro recommends that you create a password-protected zip 
file of the suspicious file, using the word “virus” as the password—then select the 
protected zip file in the Upload File field.
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• Description: Include a brief description of the symptoms you are experiencing. Our 
team of virus engineers will “dissect” the file to identify and characterize any risks it 
might contain and return the cleaned file to you, usually within 48 hours. 

Note: Submissions made through the submission wizard or virus doctor are addressed 
promptly and are not subject to the policies and restrictions set forth as part of the 
Trend Micro Virus Response Service Level Agreement.

When you click Next, an acknowledgement screen displays. This screen also displays a 
case number for the problem you submitted. Make note of the case number for tracking 
purposes.

If you prefer to communicate by email, send a query to the following address:

virusresponse@trendmicro.com

In the United States, you can also call the following toll-free telephone number:

(877) TRENDAV, or 877-873-6328

Security Information Center
Comprehensive security information is available over the Internet, free of charge, on the 
Trend Micro Security Information Web site:

http://www.trendmicro.com/vinfo/

Visit the Security Information site to:

• Read the Weekly Virus Report, which includes a listing of risks expected to trigger in 
the current week, and describes the 10 most prevalent risks around the globe for the 
current week

• View a Virus Map of the top 10 risks around the globe

• Consult the Virus Encyclopedia, a compilation of known risks including risk rating, 
symptoms of infection, susceptible platforms, damage routine, and instructions on 
how to remove the risk, as well as information about computer hoaxes

• Download test files from the European Institute of Computer Anti-virus Research 
(EICAR), to help you test whether your security product is correctly configured

• Read general virus information, such as:
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• The Virus Primer, which helps you understand the difference between viruses, 
Trojans, worms, and other risks

• The Trend Micro Safe Computing Guide

• A description of risk ratings to help you understand the damage potential for a 
risk rated Very Low or Low vs. Medium or High risk

• A glossary of virus and other security risk terminology

• Download comprehensive industry white papers

• Subscribe, free, to Trend Micro’s Virus Alert service, to learn about outbreaks as 
they happen, and the Weekly Virus Report

• Learn about free virus update tools available to Webmasters

• Read about TrendLabs, Trend Micro’s global antivirus research and support center

To open Security Information:

1. Open the IWSVA management console.

2. Click Security Info from the drop-down menu at the top-right panel of the screen. 

The Security Information screen displays.
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Appendix E

Creating a New Virtual Machine Under 
VMware ESX for IWSVA

This appendix describes how to create a new virtual machine for InterScan Web Security 
Virtual Appliance (IWSVA).

• Introduction on page E-2

• Creating a New Virtual Machine on page E-2

• Powering On the IWSVA Virtual Machine and Completing the Installation on page E-16
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Introduction
The actual installation of ESX is not covered in this document. Refer to VMware's 
product documentation to install this product.

The steps outlined in the following section detail the process to create a new virtual 
machine under VMware ESX to install IWSVA. 

Creating a New Virtual Machine
Use the following steps as a guideline for creating the virtual machine for your 
environment. The number of CPUs, NIC cards, memory, and hard disk space selected 
should reflect the requirements for your deployment. The values entered here are for 
instructional purposes. 

To create a new virtual machine:

1. Open the VMware Virtual Infrastructure client and click the Configuration tab.

2. From the Hardware area, click Storage.
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3. In the Storage area, double click a storage area that contains enough space to 
upload the IWSVA ISO. 

FIGURE E-1.   Configuration Tab
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The Datastore Browser window opens. 

FIGURE E-2.   Storage Area

4. From the button bar, click the upload button (database icon with upward-pointing 
arrow) and upload the IWSVA ISO to this datastore. 

5. Close the datastore after the upload has completed.

To create the virtual machine

6. From the menu bar, select File > New > Virtual Machine.
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The New Virtual Machine Wizard appears.

FIGURE E-3.   Virtual Machine Configuration

7. Under Virtual Machine Configuration, leave Typical selected.

8. Click Next.
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The Name and Location Selection page appears.

FIGURE E-4.   Name and Location of Virtual Machine

9. Type in the Name field, an appropriate machine name and then click Next.
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The Virtual Machine Datastore Selection page appears.

FIGURE E-5.   Virtual Machine Datastore

10. Select the datastore where the virtual machine will reside. 

This does not have to be the same datastore used to upload the IWSVA ISO. 

11. Click Next.
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The Virtual Machine Guest Operating System screen appears.

FIGURE E-6.   Virtual Machine Guest Operating System

Note: If you are using ESXi 5.0, you must select Linux as the Guest Operating System and 
Other 2.6.x Linux (64-bit) as the Version.

12. For the guest operating system, select Linux and a 64-bit Linux version.

13. Click Next.
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The New Virtual Machine Wizard (Virtual CPUs) screen appears.

FIGURE E-7.   Virtual Machine CPU

14. Select the number of processors for the virtual machine. 

IWSVA takes advantage of the Virtual SMP, so select the maximum number of 
virtual processors available.

15. Click Next.
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The New Virtual Machine Wizard (Memory) screen appears.

FIGURE E-8.   Virtual Machine Memory

16. Allocate 4096MB of memory as a minimum for IWSVA. 

17. Click Next.
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The New Virtual Machine Wizard (Memory) screen appears.

FIGURE E-9.   Virtual Machine Network

18. Accept the default network settings and then click Next. 

Note: Trend Micro recommends using E1000 or VMXNet3 for the adapter type. Silicon 
bypass cards are also recognized by VMware and can be used as normal network 
cards.
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The Virtual Disk Capacity screen appears.

FIGURE E-10.   Virtual Disk Capacity

19. For testing purposes, it is adequate to leave the 50GB disk allocation at its default. 

For production environments, provide at least 300GB for logging and reporting 
purposes. See Hardware Requirements on page 1-2 for more information on disk space 
allocation.

20. Click Next.
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The New Virtual Machine Wizard (Ready to Complete New Virtual Machine) 
screen appears.

FIGURE E-11.   Ready to Complete

21. Check the Edit the virtual machine settings before submitting check box and 
then click Continue.
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The Virtual Machine Properties screen appears.

FIGURE E-12.   Virtual Machine Properties screen

22. Click on the floppy drive and then click Remove. 

23. Click Resources tab, and reserve CPU and memory for IWSVA. 

WARNING!  If you skip this step, IWSVA will not run normally.

24. Select the New CD/DVD option and then select the Datastore ISO file radio 
button on the right hand side.

25. Click Browse and then select the IWSVA ISO that was uploaded in Step 4. 

If you did not copy the Installation ISO onto the VMware server's hard disk, then 
you can select Host Device or Client Device from which to load the installer. 
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Client Device uses the remote workstation's CD/DVD ROM drive to perform the 
installation and Host Device uses the VMware Server's CD/DVD ROM drive to 
perform the installation. Using one of these two methods saves about 500 MB or 
more of disk space on the VMware server.

26. Ensure that the Connect at power on check box for the New CD/DVD is 
checked.

Note: When IWSVA is installed on a VMware ESX server and configured in Transparent 
Bridge mode, you must enable the virtual switch to accept the Promiscuous mode in 
the ESX server.  
 
When deploying IWSVA in bridge mode, do not connect the two data network 
interfaces to the same switch; otherwise, a loop will be created in your network. 

FIGURE E-13.   Promiscuous mode in the ESX server

27. Click Finish.

The new IWSVA 6.5 SP2 Virtual Machine is now ready and configured to be 
powered on and begin the installation process.
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Powering On the IWSVA Virtual Machine and 
Completing the Installation

Use the following steps as a guideline for completing the installation and powering on 
the virtual machine.

To power on a new virtual machine:

1. From the VMware Virtual Infrastructure client Console, select the name of the 
virtual machine you previously created.

2. Right-click the name and select Power, then select Power On. The virtual machine 
will power on.

3. Connect to the IWSVA virtual machine’s console.

To connect to the IWSVA virtual machine’s console:

1. From the VMware Virtual Infrastructure client Console, click the name of the 
virtual machine you created.

2. From the right frame, select the Console tab. 

The IWSVA virtual machine logon prompt appears.

3. Type enable as the user name.

4. Type the password.
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Appendix F

Creating a New Virtual Machine Under 
Microsoft Hyper-V for IWSVA

This appendix describes how to create a new virtual machine for InterScan Web Security 
Virtual Appliance (IWSVA) under Microsoft Hyper-V.

• Introduction on page F-2

• Installing IWSVA 6.5 SP2 on Microsoft Hyper-V on page F-3
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Introduction
Starting with IWSVA 5.1 SP1, Microsoft Hyper-V based virtual platforms are 
supported. This document provides a step-by-step installation guide to install IWSVA 
6.5 SP2 on Hyper-V based virtual machines.

The actual installation of Hyper-V is not covered in this document. Refer to Microsoft’s 
product documentation to install this product.

The procedure outlined in this document describes how to install IWSVA 6.5 SP2 onto 
a Windows 2012 Server R2 Hyper-V server. You must have the proper Microsoft 
Windows 2012 Server R2 with Hyper-V support installed before proceeding. 

IWSVA Support for Hyper-V
IWSVA 6.5 SP2 will only support Hyper-V 2.0 with Windows Server 2008 R2 or 
Hyper-V3.0 with Windows Server 2012 R2. The IWSVA installation for Hyper-V 
platforms supports forward proxy mode, WCCP mode, ICAP mode, reverse mode and 
Transparent Bridge mode.

Hyper-V Virtualization Modes
Hyper-V provides two virtualization modes that support IWSVA:

1. Full-virtualization

2. Para-virtualization

Due to Hyper-V’s performance limitations in full-virtualization mode, it is 
recommended to install IWSVA in para-virtualization mode. This allows IWSVA to 
achieve much higher throughput performance and supports enterprise networking 
environments. IWSVA 6.5 SP2 provides the necessary integrated Hyper-V drivers (the 
last version of integration services is v3.1) to support the installation under Hyper-V 
V2/V3 as a para-virtualization virtual machine.
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Installing IWSVA 6.5 SP2 on Microsoft Hyper-V
Use the following steps as a guideline for creating the virtual machine for your 
environment. The number of CPUs, NIC cards, memory, and hard disk space selected 
should reflect the requirements for your deployment. The values entered here are for 
instructional purposes. 

To create a virtual network assignment:

1. From the Hyper-V Server Manager menu, right click Hyper-V Manager.

A menu appears. 

FIGURE F-1.   Connect to Server
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2. Select Connect to Server.

A dialog box appears prompting you to select the location of the virtualization 
server that you want to connect to.

FIGURE F-2.   Location of Virtualization Server

3. Select the location of the virtualization server and click OK.

4. With the correct Hyper-V server connected, right click on the Windows server and 
select Virtual Network Manager. 

FIGURE F-3.   Select Virtual Network Manager
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5. Create a new virtual network by selecting External from the list of options and 
clicking Add.  

FIGURE F-4.   Adding the “External” Virtual Network
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6. From the External pull-down menu, select the physical network adaptor you want 
to connect to the new virtual network to support IWSVA 6.5 SP2. See Figure F-5.

Note: The physical adaptor must be connected to the network and have access to the 
corporate network and the public Internet.

FIGURE F-5.   Physical Network Adaptor Selection

WARNING! You must reserve CPU and memory for IWSVA. If you skip this step, 
IWSVA will not run normally.
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Importing the IWSVA Image
After configuring the Hyper-V network settings, import the IWSVA 6.5 SP2 image into 
the new virtual machine. Trend Micro provides a pre-configured Hyper-V IWSVA 6.5 
SP2 image for rapid deployment. To install IWSVA, import this pre-configured image 
onto your Windows server using the following steps.

To import the IWSVA image:

1. In Server Manager, locate the folder of the virtual machine you want to configure 
and right click the name.

A menu appears.

FIGURE F-6.   Importing a New Virtual Machine
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2. Select Import Virtual Machine from the menu options.

The Import Virtual Machine dialog box appears. 

FIGURE F-7.   Configuration for Importing IWSVA Image

3. In Location, specify the location of the folder that contains the virtual machine 
files.

4. In the Settings area, select the option to copy the virtual machine.

5. Select the option to duplicate all files.

6. Click Import.
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A progress bar appears indicating the status of the import process.

FIGURE F-8.   Image Importing Progress

Assigning Resources to IWSVA
After the IWSVA image has been successfully imported, you can configure the necessary 
resources and assign them to the IWSVA virtual machine. This includes the network 
adaptor, CPU, memory, and hard disk space.

To assign resources to IWSVA:

1. In Server Manager, locate the folder of the virtual machine you want to configure 
and click the server name.

The Virtual Machines area appears. 
F-9



Trend Micro™ InterScan™ Web Security Virtual Appliance 6.5 SP2 Installation Guide 
2. Right click the virtual machine you want to configure.

A menu with a list of options appears.

FIGURE F-9.   Settings Menu Option
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3. Select the Settings... option.

The Settings box for that virtual machine opens. 

FIGURE F-10.   Assigning Virtual Network Adaptor to IWSVA Virtual 
Machine

4. In the Hardware area, select Network Adapter.

5. In the Network pull-down menu, select the external network adaptor that you 
previously configured in step 6 of the procedure: To create a virtual network assignment: 
on page F-3

6. In the Hardware area, select Processor to configure the virtual machine’s CPU.
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The Processor area appears.

FIGURE F-11.   Assigning Processors to the IWSVA Virtual Machine

7. Type the number of logical processors to allocate to the virtual machine. 

Hyper-V allows you to assign up to four logical processors. IWSVA requires a 
minimum of two logical processors. Refer to the IWSVA 6.5 SP2 Sizing Guide for 
more information on sizing your environment.
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8. In the Hardware area, select Memory to allocate memory for your IWSVA 
environment.

The Memory area appears.

FIGURE F-12.   Assigning Memory to the IWSVA Virtual Machine

9. Type the appropriate amount of memory you want to allocate to your IWSVA 
environment.
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10. In the Hardware area, select the hard disk controller you want to create the virtual 
hard disk on.

The IDE Controller area appears.

FIGURE F-13.   Adding a Hard Drive to the IWSVA Virtual Machine

11. Select Hard Drive from the list of options.

12. Click Add.
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The Hard Drive area appears.

FIGURE F-14.   Hard Drive Settings

13. In the Media area, leave the Virtual hard disk (.vhd) file option selected.

14. Click New.

The New Virtual Hard Disk Wizard appears.

15. Click Next.
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The Choose Disk Type screen appears.

FIGURE F-15.   Configure Virtual Hard Drive Wizard
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16. Leave the Fixed size option selected and click Next.

The Specify Name and Location screen appears.

FIGURE F-16.   Specify Hard Drive Name and Location

Note: For this example, we name the virtual hard drive “IWSVA_30Gig” and set the 
size to 30GB. We select Fixed Size for maximum performance. This is Trend 
Micro’s recommended disk volume type for the IWSVA application. 

17. Name the hard disk appropriately for your application.

18. Select the location where the virtual hard disk file will be stored.
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19. Click Next.

The Configure Disk screen appears. 

FIGURE F-17.   Specify Hard Drive Size

20. Keep the default Create a new blank virtual hard disk option selected.

21. In Size, type the disk size you want to allocate to the virtual hard drive.

22. Click Next.
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A summary screen appears that lists the configuration of the virtual hard drive.

FIGURE F-18.   Virtual Hard Drive Configuration Summary

23. Click Finish to complete the configuration of the virtual hard disk.
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A progress bar appears indicating the status of the hard disk creation process. When 
this process is finished, the Hard Drive area appears.

FIGURE F-19.   Adding the Virtual Hard Disk to the SCSI Controller

24. In the Hardware area, select the newly created hard drive that was created in the 
previous steps.

25. In the Hard Drive area, select SCSI Controller in the Controller menu.

26. Click Apply.

27. Click OK to complete assignment of resources to the IWSVA virtual machine.

Powering On the IWSVA Virtual Machine and Completing 
the Installation

To complete the installation of the IWSVA virtual machine, you must power on the 
virtual machine, connect to the virtual machine’s console, and configure various 
parameters as described in the following procedures.
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To power on the IWSVA virtual machine:

1. From the Server Manager, click the name of the virtual machine you created. 

2. From the menu bar, select Action.

3. From the menu, select Start. This will power on the virtual machine. You can now 
connect to the IWSVA virtual machine’s console.

To connect to the IWSVA virtual machine’s console:

1. From the Server Manager, right click the name of the virtual machine you want to 
configure.

2. From the menu, select the Connect... option.

The IWSVA virtual machine logon prompt appears.

3. Type enable as the user name. 

4. Type the password. 
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To check and/or change the keyboard type:

5. Check the keyboard type and reconfigure it if necessary.

FIGURE F-20.   Displaying the Current Keyboard Type

a. To check the keyboard type, at the system prompt, type:

show system keyboard

The current keyboard type will display. By default, the keyboard type is set to 
“US”. 

b. If you want to change the keyboard type, at the system prompt, type:

configure system keyboard <keyboard type>
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Where <keyboard type> is the code for the specific keyboard type you want to 
configure. 

FIGURE F-21.   Configure the System Keyboard Type
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To complete the hard disk configuration:

1. At the enable system prompt, type:

configure system harddisk

This action will add the new virtual hard drive in the IWSVA /var folder.

FIGURE F-22.   Configuring the Virtual Hard Disk for IWSVA Use

Note: IWSVA supports the addition of one virtual hard drive with each virtual 
machine.

To configure the network settings:

1. At the enable system prompt, type the following commands to configure the 
network settings for the IWSVA virtual machine:

a. To configure the IP address of the network interface card, type:

configure network interface static <eth0> 10.10.10.1 
255.255.25
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Where <eth0> is the name of the virtual network adaptor that was previously 
created.

FIGURE F-23.   Configuring the IP Address

Note:  Make sure you use the proper virtual Network Interface Card (NIC) name 
that was created earlier for IWSVA’s use.
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b. To configure the Gateway address, at the system prompt, type:

configure network route default 10.10.10.254

FIGURE F-24.   Configuring the Default Gateway
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c. To configure the Domain Name Server (DNS) assignment, at the system 
prompt, type:

configure network dns 10.10.99.1 10.10.100.2

FIGURE F-25.   Configuring the DNS Server
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d. To create a network host name, at the system prompt, type:

configure network hostname my_iwsva.company.com

FIGURE F-26.   Configuring the Hostname

Accessing the IWSVA Web console
After the network parameters are configured, you can now access IWSVA’s Web  
console to change the deployment mode, review the default policies, and make any other 
configuration settings. 

For more information on configuring IWSVA, refer to the IWSVA Administrator’s 
Guide. 

To access IWSVA’s Web management interface, point your browser to:

https://iwsva_ip_address:8443

Refer to Post-Installation Notes on page 3-11 for further instructions.
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